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To the student

Nelson VICmaths is your best friend when it comes to studying
Mathematical Methods in Year 11. It has been written to help you
maximise your learning and success this year. Every explanation,
every exam hack and every worked example has been written with
the exams in mind.

STEP 1

Study each
Worked example

NELSON

VICmat

)

STE 2

Complete the

The 3 Steps Matched example in the
to mastering Mastery Workbook
each topic

mathematic
methods 11

NELSON

VICmatt

:
s

mathematical
methods 11

s I E 3 mastery workbook

Do the Mastery

NELSON

questions in the
exercise that are

et s linked to the
Worked example

9780170448260 To the student
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To the teacher

Now there’s a better way to VCE maths mastery.

Nelson VICmaths 11-12 is a new VCE mathematics series that is backed
by research into the science of learning. The design and structure of

the series have been informed by teacher advice and evidence-based

pedagogy, with the focus on preparing VCE students for their exams and

maximising their learning achievement.

Using backwards learning design, this series has been built by
analysing past VCE exam questions and ensuring that all theory and
examples are precisely mapped to the VCE Study Design.

To reduce the cognitive load for learners, explanations are clear and
concise, using the technique of chunking text with accompanying
diagrams and infographics.

The student book and workbook combination has been designed for
mastery of the learning content.

The exercise structure of Recap, Mastery and Exam practice leads
students from procedural fluency to higher-order thinking using
the learning technique of interleaving.

Exam practice includes exam-style questions and graded past
VCE exam questions with success percentages based on VCAA
performance data.

The cumulative structure of Exercise Recaps and chapter-based
Cumulative examinations is built on the learning and memory
techniques of spacing and retrieval.

Nelson VICmaths Mathematical Methods 11

9780170448260
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In each chapter

Study Design coverage and extracts
are shown at the front of the chapter,
along with a listing of Nelson MindTap
chapter resources.

Important facts and formulas are
highlighted in a shaded box.

Important words and phrases are
printed in blue and listed in the
Glossary and index at the back of
the book.

Worked examples are explained
clearly step-by-step, with the
mathematical working shown on the
right-hand side.

Links to scaffolded matched examples
in the Mastery Workbook (WB).
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UNIT 1, AREA OF STUDY 2: ALGEBRA, NUMBER AND STRUCTURE

« use of symbolic notation to develop algebraic expressions and represent functions, relations, equations,
and systems of simultaneous equations.

. into, and of, these

« recognition of equivalent and of algebraic involving different forms

of polynomial and power functions, the use of distributive and exponent laws applied to these functions,
and manipulation from one form of expression to an equivalent form

solution of a set of simultaneous linear equations (geometric interpretation only required for two variables)
and equations of the form (x) = g (x) numerically, graphically and algebraically.

Note: The bisection method is covered in Chapter 3, Polynomials.

w
]
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w
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°
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z
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0
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o
>
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2
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VCE Mathematics Study Design 2023-2027 p. 44, © VCAA 2022

Video playlists (9): 12 Binomial prod cial products

fa formula

18 Inequaliti
VCE question analysis Equations and inequal

Worksheets (9):

A R
sources above, visit
com.au/nelsonmindtap

The general form of a straight line is ax + by + ¢ = 0, where a, b and c are integers and a is positive.
The gradient-intercept form is y = mx + ¢, where m is the gradient and c is the y-intercept.

The point-gradient form is y — y;, = m(x — x,), where m is the gradient and (x;, ;) is a point on the line.

A X . " q q
The intercept form is = 1, where a is the x-intercept and b is the y-intercept.
a

b

WORKED EXAMPLE Equation of a straight line

a passes through (2, 1) and has gradient -2
b has y-intercept 5 and gradient 2

¢ passes through (-2, 3) and (4, 1)

d has x-intercept 2 and y-intercept —5.

|
Find the equation of the straight line that |
Steps Working ;
7a 1 Write the point-gradient form. Y=y =mx—x)) ‘
2 Substitute values. y-(1)=-2(x-2)
3 Simplify and express in general form. y+l=-2x+4 ‘
2x+y-3=0
b 1 Write the point-gradient form. y=y=m(x—x)) ‘
2 Substitute m = 2 and the point (0, 5). y—5=2(x—0) |
3 Simplify and express in general form. y-5=2x ‘
2%—y+5=0 |
¢ 1 Find the gradient. = =k

n~

Write the point-gradient form.

©

Substitute the ‘simpler’ point, simplify and
express in general form.

a

Find the gradient.

n~
plo

Write the point-gradient form.

©

Substitute the ‘simpler’ point, simplify and
express in general form.

5x—2y—10=0

About this book
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Exam hacks highlight valuable exam hints and common

student errors.

Using CAS provides clear instructions for
TI-Nspire and Casio ClassPad calculators.

@ Exam hack

An improper fraction answer is preferred to a mixed number. Do not give a decimal answer unless it is asked for.

Domain and range

Find the range of f: [-5, 6] = R, f(x) =x - 4x+3.

Dol fidord—4 vo 3y S sase Do
rtisfdiha)

bl -t
A1)

A-z) w

1 Press menu > Actions > Define.

2 Define the function as shown. Press ctrl + = to
access the mini-palette for the | and < symbols.

3 Press menu > Calculus > Function Minimum.

4 Enter f(x),x to determine the x value when the
function is a minimum.

5 Repeat by selecting Function Maximum to
determine the x value when the function is
amaximum.

6 Substitute these values into the function to
determine the corresponding y values.

7 Add a Graphs page.

8 Press menu > Window/Zoom > Window
Settings and adjust the window settings for
these minimum and maximum values.

9 Press menu > Trace.

10 When you enter an x value, the cursor will
jump to that point.

11 Press enter to label the coordinates of
the point.

12 Use Trace to confirm the minimum and
maximum values of the function.

Graded exercises, including Recap, Mastery and
Exam Practice questions, are linked to worked
examples and Using CAS, and include past VCE exam
and exam-style questions.

Recap questions revise skills from the previous
exercise, Mastery questions provide skill practice,
while Exam practice applies learned skills to VCE
exam and exam-style problems.

Past VCE exam questions are clearly tagged and
graded by colour-coded success percentages based

on VCAA data, presented in the order Exam 1, Exam 2A,
Exam 2B.

CAe.V. 20131Q5b | 76%

KEY
2021 2021 exam year
<year>N Northern hemisphere exam
<year>S VCAA sample exam
Technology not permitted
1 Exam 1 (tech-free)
2A Exam 2, Section A (multiple-choice)
2B Exam 2, Section B

For multiple-choice questions and other 1-mark
questions, the success percentage is the percentage
of students who answered correctly. For questions
worth more than 1 mark, the success percentage is
the mean percentage result scored by students.

Success percentage range m

80-100% (straightforward) i
60-79% (standard) CO
0-59%  (complex) 45%

Note: Questions from Northern hemisphere and VCAA
sample exams do not have success percentages.

Nelson VICmaths Mathematical Methods 11

2.3 Domain and range ANSWERS p. 496

Recap

1 Part of the graph of f(x) is shown.
Which of the following features are correct?
I There is an asymptote at about x = 1.
Il There is an asymptote at about y = 1.
Il There is an asymptote at about x = 2.
IV There is an asymptote about y = 2.
V There is a point of inflection at about (-2.3, 1.4).
A LIVandV
B Iand IV only
C Allof LILIIL IV and V
D All except IV
E Iland I only

2 f(x)=0.5x—2.Find f ' (x).
A 2y+2 B 2x+2 C 2x+4 D 2y+4 E 2x-4

Mastery

WORKED ExAMPLE 10 | What is the maximal domain of each function?

1

a y= b f)=Yx+1 ¢ f)=—

x+5 x -4

Exam practice 80-100%  60-79% 0-59%

4 (2 marks) State the natural domain and range of f(x) = Vx* — 4.

5 XN 20162401 ] (92%  The linear function f: D — R, f(x) = 5 — x has range [~4, 5).
The domain D is
A (0,9] B (0,1] Cc [5-4) D [-9,0) E [1,9)

6 80% The linear function f: D — R, f(x) = 4 - x has range [-2, 6).
The domain D of the function is
A [-2,6) B (-2,2] C R D (-2,6] E [-6,2]

7 AN 20122403 ] (69%  The range of the function f: [-2,3) = R, f(x) =x* = 2x— 8 is
A R B (-9,-5] C (5,0 D [-9,0] E [-9,-5)

9780170448260



At the end of each chapter

VCE question analysis leads students through

a VCE-style exam question that exemplifies the
chapter, discussing how to approach the question,
providing advice on interpreting the question and
common student errors.

VCE QUESTION ANAI

IS

AVCE-style question (9 marks)
An object lighter than water is projected from the top of a seaside cliff. It travels in a parabolic path
and hits the water 15 metres below its starting point as shown in the diagram.

The equation of the parabolic path is y = 5x(b - x), where x and y are in metres and b is a constant.
‘The starting point is (0, 0). The maximum height of the object is 20 metres above the cliff. After
hitting the water, the object’s buoyancy makes it follow another parabolic path until it reaches the
surface of the water. Its path under the water reaches a depth half of the height it reached above the cliff.

a Find the value of b. 3 marks
b Write an equation for the water level (ignoring any waves). 1 mark
¢ Find the horizontal distance from the cliff to where the object hits the water, correct to

2 decimal places. 2 marks
d The equation of the object’s parabolic path under the water is y = (x - h)* + k, where x and

y are in metres and h and k are constants. Hence, find the equation of this path, using values
of h and k correct to two decimal places. 3 marks

Reading the question
« The 2 parabolas have separate quadratic equations.
« The measurements 15m and 20 m are needed for this question.
« The point of projection at the top of the cliff is (0, 0).
Thinking about the question

« The parabola under the water is concave up, so x” has a positive coefficient.

« The water level is parallel to the x-axis (horizontal).
b

« The turning point of a parabola occurs at x = — % and is halfway between the zeros.
a

+ The answer for part s to be approximate, so you can use CAS for intersection of graphs.

Chapter summary for easy reference.

Cumulative examinations 1 and 2 are
mini-exams based on the format of the
VCE examinations 1 and 2, with around
50% of questions focusing on the chapter
in which they appear.

9780170448260

RO Croptersommary

Index laws The quadratic formula

b+ b’ — dac
x=z 2N AR
2a

Solve using the quadratic formula:

1 Write the equation in general form:
ad +bx+c=0

2 Identify the values of a, b and ¢ and substitute
into the quadratic formula.

3 Simplify where necessary (including the surd).

The discriminant

In the quadratic formula, the expression under

the square root symbol, A = b” — 4ac, is the

discriminant.

Binomial expansions

A binomial expression has 2 terms, for example,
x+4and 3¢ 6.

The sign of its value gives information about
the number of roots of the quadratic equation,
ax’ +bx+c=0:

A binomial product is 2 or more binomial
expressions multiplied together.

Tt has the form (a + b)(c +d).
(a+b)(c+d)=ac+ad+bc+bd

A quadratic expression is of the form ax® + bx + c.

« If A <0, the quadratic equation has no real roots.

« If A=0, the quadratic equation has 1 real root,
which is rational.

FOIL method « IfA> 0, the quadratic equation has 2 real roots.

First terms, Outer terms, Inner terms, Last terms

Perfect squares
(a+b)*=a*+2ab+b*

~ If Avis a square number, the 2 roots are rational.
- If Ais a not a square number, the 2 roots are
irrational (surds).

—by=d’-2ab+b . :
(a-by=a . Changing the subject of a formula
Difference of two squares Aliteral equation is an equation with more than one
52

Total number of marks: 10 Reading time: 4 minutes ‘Writing time: 15 minutes

Technology is NOT permitted.

1 (6 marks) Lety= prye +1.
a Find the value of y when x = 2. 1 mark
b Find the value(s) of x such that y=3. 2marks
¢ Evaluate y when x=—1. 1 mark
RGOt TRl b = LN Crocsit s the ETE phIGE e e e Y e p o1t (21 1)

i -1y
where a and b are integers.

Find the values of @ and b. 2 marks

2 (2marks) Find the value of the constant a in the rule y = ax” + Jx given that y =
when x = 64.

About this book
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Video playlists

Worksheets

Skillsheets

Xii

At the end of the book

e 3(x-2)

g 8-

f (et 1)(x-3)
h (2x+3)(x-5)

E 1.1 i Bx+2)(x-5)
128 2 12 8 a (2x+7) b (2x-37 © (m+3n)
3 a 2% b 2 c 2™ 9B 10 E 1" 12 E
7 5 .
d 324 ey fa E 1.4
1
4a L el 1 a(e+2)(x—2ax+1) 2 (x+3)(x-3)ax+2)
d 37 e 2 £ oo 3 46412048 4 (x-1)
54 65 7¢C 8E S x=-12
9 x-2 6 x=0,x=-9
7A 8 C 9D
10 x=—6 o .
= 1,x=0,x=
1E 12 D 13 E 14 E Fehemh
5B 6 A 7 c 8 c MDD 12¢ 13aA c 15
E 1.2 E 1.5
121 2 1ax=—t br=-2x=2
x=t c 2
2D
3a a6 b 812
¢ Poxos d 6sl3e6 3 ak=-51 b v=-7,5 c x=18
1
4 X i6x+5 5 4 +12x+5 4x:; x=-3
6a -1 b 44
c ¥-9 d 6x+3 3
e —ix+4 f -16¢ +48x-36 2
—d s 7 aA=25

A combined Glossary and index.

Nelson MindTap

Answers (with worked solutions provided
on Nelson MindTap for teachers to
allocate to students).

acceleration The rate of change of velocity of a moving
object, represented by the function a = % where v is the
velocity (signed speed). Conversely, v= [ a(t)dt. (pp- 244, 441)
addition rule for probabilities

Pr(AUB)=Pr(A)+Pr (B)—Pr (AN B). (p.315)
amplitude The vertical distance from the centre of a

cireular function to its maximum and minimum poins
The amplitude of y = sin (x) and y = cos () s 1. (p. 347)

yesin(o)
Ampline

y
1

base The number being raised to a power; for example,
in 2°, the base is 2. (p. 4)

binomial expression An algebraic expression with two
terms, such as x+ 4 or 3x* ~ 6. (p. 6)

binomial product Two or more binomial expressions
multiplied together; for example, (3x-+2)(x ~ 1). (p. 6)
bisection method An approximation method for finding
the zeros of a function (or the roots of an equation) that
involves examining the signs of the values of the function
repeatedly to narrow in on the zero. (p. 107)

central difference approximation A formula that
approximates the gradient, m, of the tangent at a

point (x,f () on the graph of y = f(x) using the values
of f(x) a small distance  units on cither side of , so

x x L3 x X

2 2

1
Period

anti-derivative (or integral or primitive) The opposite of
the derivative. The anti-derivative of  (x) is a function F(x)
whose derivative s f(x): F'(x) =f (). (p. 476)
anti-differentiation (or integration) The opposite of
differentiation; that s, the process of finding the
anti-derivative or integral. (p. 476)

Fefth) - SN, (p. 236,393)
2h

central value The mean value of a circular function,
the average y value of the function. (p. 347)

circular function A trigonometric function such as
y=sin(3), y= cos () or y = tan (x). (p. 335)

co-domain The set of values that the range of a
function or relation can fall in. For example, the function
£:10.71> R,g(x) = " + 4 has domain [0,7], co-domain
Rand range [4,9). (p. 39)

coefficient The number multiplying a variable.

For example, in x - 31 + 6x the coefficient of x” is 3.
(p.78)

Nelson MindTap is an online learning space that provides students with tailored learning experiences.

Access tools and content that make learning simpler yet smarter to help you achieve VCE maths mastery.

Nelson MindTap includes an eText with integrated interactives and online assessment.

Margin links in the student book signpost multimedia student resources found on MindTap.

Nelson MindTap for students:

o Watch video tutorials featuring expert teacher advice to unpack new concepts and develop your

understanding.

o Revise using quizzes, worksheets and skillsheets to practise your skills and build your confidence.

» Navigate your own path, accessing the content, analytics and support as you need it.

Nelson MindTap for teachers*:

o Tailor content to different learning needs — assign directly to the

student, or the whole class.

o Monitor progress using assessment tools like Gradebook and

Reports.

o Integrate content and assessment directly within your school’s LMS

for ease of access.

o Access topic tests, teaching plans and worked solutions to each

exercise set.
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*Complimentary access

to these resources is only
available to teachers who use
this book as part of a class
set, book hire or booklist.
Contact your Cengage
Education Consultant for
information about access
and conditions.
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Companion resources
Mastery Workbook i
WB

« Step-by-step scaffolding to guide students towards mastery of the course content.

o Write-in support that encourages students to show working.
o Matched examples for every worked example in the student book.
« Full integration between student book and workbook.

o Answers (worked solutions for teachers on Nelson MindTap).

Examplus

o Create and simulate exam-like conditions in minutes.
« Save time with an extensive bank of filterable and difficulty-graded questions for Year 12.
o Over 1000 past VCAA and unseen exam-style questions and solutions all in the one place.

« Extensively researched and user-tested.
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TI-Nspire CAS introduction

The latest TI-Nspire model is TI-Nspire CX II CAS. When purchasing
a new handheld, you also gain access to the student software. If you
purchase a used handheld, then you can pay an additional fee for the
student software.

Alternatively, you can connect your handheld to your computer using the
TI-Nspire™ CX II Connect web-based app, which allows you to perform a
variety of functions such as screen captures, file transfers and operating
system updates. Note that TI-Nspire non-CAS technology is also available.
It is vital that you use the CAS technology.

TI-Nspire CX Il CAS

Student book instructions

The instructions in this student book use words instead of symbols. Most keys on the keypad are clearly
labelled with a word or an abbreviation. Four words that are used to represent less obvious keys are:

Word | Key
home

catalog
template i{e
Scratchpad //@

Several keys have a second function highlighted in blue above the key. For example, press ctrl + x” to
access the square root function/ .

Applications

The applications available are outlined below.

tt CAS

8 ].14
1 Add Calculator
2 Add Graphs
3 Add Geometry
4 Add Lists & Spreadsheet
S Add Data & Statistics
6 Add Notes
7
8
9
A

Scratchpad Documents
ate 1 New

ett . Add Vernier DataQuest™
=== & 8 Add Widget
I J J B E lll . - ) 9 Add Program Editor »
Add Python »

a

Press home to view the home page. The Scratchpad When you select Documents > New from the home

options on the left are available for quick page, a list of the seven applications plus three
calculations and graphing. The Documents options  additional menu options will be displayed. From
on the right are used for navigation. The seven any application, press ctrl + | (for insert) to display
icons on the bottom are the main applications. this list and add a new page to the document.

xiv Nelson VICmaths Mathematical Methods 11 9780170448260



Menus

The instructions in this student book primarily use the Calculator, Graphs, Lists & Spreadsheet and

Data & Statistics applications (see Hints on page xviii). The following figures show the initial menu
options for these four applications. These menu options link to submenu options, which are not shown
below. On the handheld and software, the applications are referred to as Documents. In the student book
instructions, the applications are referred to as pages of the document (e.g. Add a Graphs page).

Calculator Graphs
Rlidciors 5 noil x| ;

ks 2 Number ’ By 2 View ’ =
\= 3 Algebra ’ %4 3 Graph Entry/Edit » ==
J4 4 Calculus 4 Q 4 Window/Zoom *

@ 5 Probability 4 5 Trace ’

X 6 Statistics 4 Q 6 Analyze Graph *

Fl 7 Matrix & Vector ’ 2] e ——
$ ; 1 10
‘¢ 8 Fman;e 4 B 8 Geomelry »

8 9 Functions & Programs * £ 9 Settings...

657

Lists & Spreadsheet Data & Statistics

N2 Insert » = & - B2 Pt »

B3 Data » " %

X 4 Statistics » ks 4 ’

Ed S Table » Q

| W
_, £+ 6 Settings...

2 e < -0t this problem

3

4

“« lick to add variable

If your document contains more than one page, move among them by clicking on the numbered tabs at
the top of the screen. Alternatively, press ctrl + left arrow or ctrl + right arrow. To view all the pages of a

document, press ctrl + up arrow.

All menu and submenu options include numbers. The student book instructions do not include numbers.
For example, the instruction in a Calculator page for clearing all calculations is ‘press menu > Actions

> Clear History’. The shortcut is ‘press menu > 1 > 5. For efficiency, you are encouraged to learn the
sequence of numbers for frequently used commands.

Document Settings

The document settings can be accessed in the following ways:
1 From the home page, press Settings > Document Settings.

2 From a document page, press the doc key or click on Doc at the top of the page, then select Settings &
Status > Document Settings.

3 Click on the battery icon in the top right-hand corner of the page, then select Document Settings.

9780170448260 TI-Nspire CAS introduction
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XVi

The document settings shown below are the primary ones you will be using.

Document Settings Document Settings

pla

»
4
»

il

- -

OK | Cancet Fix3 Cancet

I -
The screen above shows the default document Click in any field to display the options. The screen
settings. The Display Digits field is set to Float 6, above shows the Display Digits options. Scroll down
which means up to six significant figures will to select a specific number of decimal places.
be displayed.
Document Settings Document Settings

Radian

-

Auto

l

- -

OK Cancel e Cancel

There are three Angle options shown above. Select  There are three Calculation Mode options

either Radian or Degree. These two angle settings ~ shown above. It is recommended that you keep

can be toggled at any time by clicking on DEG or the default setting of Auto. If you require an

RAD in the top right-hand corner of the screen. approximate or decimal answer, press ctrl + enter
or include a decimal point in your calculation.

Templates

The template key is located to the right of the 9 key.

g ool rEEe ¢
oo () ea [ B s Jo &0 £ £ fa
52 B

Press template to view the template options. Most ~ The screen above shows three examples using

templates will be directly inserted, but for some, templates: an absolute value, a derivative and an
you will be prompted with a dialogue box. For integral. Many of the templates can be accessed
example, after selecting the 3 piecewise function using keys on the keyboard; for example, fraction,

template, you will be prompted for the number of  square root.
function pieces.

Nelson VICmaths Mathematical Methods 11 9780170448260



Catalog

The catalog key is located to the right of the template key. In addition to using the menus and submenus,
you can access all the commands using the catalog. The advantage of using the catalog is that it shows
the parameters required for each command at the bottom of the screen. Optional parameters appear in

square brackets.

For example:

ﬁ‘@z)’z 3% 4 off Suﬁ:smi

-
plist

ExpReq %
it *
Fodr % .
E] [ e Wizards On

factor(Expr [,Var))

Press catalog and ensure tab 1 is selected. Press F
to jump to the commands starting with E Scroll
down to factor(. The parameters for the factor
command appear at the bottom of the screen

l‘actor(,\‘ 2_ 9)

factor(\'l—B) x“=8

ractor(\'z—s,y) (=2 {2) (x+2-J2)

When you factor the expression x° - 9, the
solution is (x — 3)(x + 3). When you factor X’ -8,
the expression remains unchanged. However,

if you include the optional parameter x, the

=
o
=
(2]
=
Q
o
[+ <
=
=
)
<
(3]
w
«
o
(2]
=
—

(see red rectangle). Expr is a required parameter. expression will factorise to ( x =22 )( x + 22 )
The square brackets around Var means it is an

optional parameter.

Symbols

All symbols are listed at the end of the catalog. To access the symbol palette, press ctrl + catalog.
Frequently used symbols are available in mini-palettes by pressing the keys shown below.
S cos tan csc  sec | cot > < | % i i o | e 0
sin® | cos*  tan'  c¢sc' sec! | cot! ! -

Press trig to access the trigonometry Press ctrl + = to access Press m to access commonly

functions. the inequalities and the used symbols.

constraint symbol.

9780170448260 TI-Nspire CAS introduction xvii
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Hints

The instructions below provide a few hints to assist with using the 4 main applications.

Calculator

Define fx)=2: x+3 Done
A2) 7
g(vc):-,\'l Done
g(?) 9

S5—a S

a

w

v

There are a few options available to define or
store functions and variables.

1 Press menu > Actions > Define.
2 Press ctrl + template for the := symbol.
3 Press ctrl + var for the store symbol.

Press var to view the list of defined and stored
variables.

Graphs

Graphs & Geometry Settings

OK Cancel

Press menu > Settings to view and/or change the

settings for the Graphs and Geometry applications.

The default setting for Display Digits is Float 3 so
change this if you need greater accuracy.

The Graphing Angle is set to Auto but can be
changed to Degree or Radian.

% 1 Actions

B2 View L

H: 3 Graph Entry/Edit 3, e |

Q 4 Window/Zoom ;'

M. S Trace ok, E) Minimum

QGNWZGGM =3 Maumum

B 7 Table A- 4 Intersection

5 W S Inflection

> 8 Geometry P 6 dyldx

{3 9 Settings... 7 Intsgral

fl(r)={x"‘-4,-3s.rsz fx 8 Bounded Area
<47 © 9 Analyze Conics *

A second option for identifying key points on a

graph is to press menu > Analyze Graph. These

options prompt you for a lower bound and upper

bound to locate the point.

Nelson VICmaths Mathematical Methods 11

2 x+3px=2 7
Deﬁnej(\‘)-} x+3|-2sxs2 Done
A2) 7
A2) undef
ClearAZ Done
A2) A2)

-

Press ctrl + = to access the constraint symbol (|).
1 Use constraint for substitution.
2 Use constraint to limit the domain of a function.

Press menu > Actions > Clear AZ to delete defined

variables.

457 n:(2,0)

The constraint command can also be used in a
Graphs page to specify a domain.

Press menu > Trace > Graph Trace to identify
points on a graph.

% 1 Actions ’
P‘i 5
-~ 2 Paint On
(.13 Pointby Coordinates  (p)
4 Intersection Point(s)
S Line i
* 6 Segment ints &Lines »
~ 7 Ray apes »
7S 8 Tangent :asurement »
|~ 9 Vector nstruction
“v A Circle arc insformation »

A third option is to press menu > Geometry >
Points & Lines. Locate points of intersection or
place points on the graph and move them along
the graph. Click on a coordinate to manually
change a value.

9780170448260



Lists & Spreadsheet

B W N -
WO & -
!
pey

The columns in the Lists & Spreadsheet application

can be used for lists. Above, the values in the list in
column B are the squares of the values of the list
in column A. It can also be used as a spreadsheet.
The value in cell C3 is the value in cell A3 raised

to the power of 4.

Data & Statistics

11|12

@
124
'>°| ®
>
6
®
0l @
T T T T " } T T L) B=
08 12 16 20 24 28 32 36 40
x_val

The Data & Statistics application is reliant on lists
generated in other applications. It is designed

for ungrouped data. The plot above displays the
x_val and y_val lists from the Lists & Spreadsheet
application.

9780170448260

A x_val

:
1 1

4
9 81
16

n _vgval:"a[ ]“ ¥

Ey val C 0

B oW N -

Calculations using lists can be completed using
the column headings A, B, C etc. Lists need to be
labelled to be used in other applications. The list
A above has been labelled x_val and list B labelled
y_val. List names cannot have spaces so spaces are
replaced by asterisks. Alternatively, press ctrl +
space bar to insert the underscore character
instead of a space.

E 1 PlotType :i:

B 2 Plot Propei

% 3 Actions

k4 4 Analyze E£ 4

Q 5 Window/Z¢| f

£ 6 Settings... |- ST
6 B
0l ® ,,,,’,,,,_. ~L S

08 12 16 20 24 28 32 36 40

x_val

Press menu > Plot Type to view the various

graphing options. Options 1 to 4 are for univariate

data (one list). Options 5 and 6 are for bivariate
data (two lists). Options 7 to 9 are for categorical
data (one list).

TI-Nspire CAS introduction
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XX

567

Add a Graphs page and press esc to hide the Graph
Entry Line.

Press menu > View > Grid > Dot Grid.

Press menu > Geometry > Shapes to view the
submenu options. Select Circle.

Click on a centre and another point to draw a circle.

BN *Doc pea [i] X
Q 667 AY
134.8°
A %
10 / 1 10
point
.67

Press menu > Geometry > Measurement > Angle

then click on the three points to measure the angle.

The tool being used is shown in the top left-hand
corner of the screen. Press esc to remove a tool,
which will then allow you to move objects around
the screen.

Operating systems

Ensure the latest operating system is installed on
your handheld and software.

Installing the latest operating system is relatively
straightforward. Using the USB cable provided,
connect the handheld to a computer with the
student or computer link software installed. Select
Help > Check for OS Updates. If you see a message
that a new OS is available, follow the links to
install it. Alternatively, go to the TI website at
https://education.ti.com/ to download the latest
operating system. Select Tools > Install OS then
select the downloaded file.

To determine the version of your operating system,
press home > Settings > Status. At the time of
publication, the operating system for the CX II

is version 5.4.0.259.

Nelson VICmaths Mathematical Methods 11
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Press menu > Geometry > Points & Lines to view

the submenu options. Select Segment then draw

the segments.

Press menu > Geometry > Measurement > Length

then click on the segments to measure them.

1 Actions
2 View »
I\ 3 Trace
4 Points & Line;
& 5 Shapes I~
% 6 Measuremen’
- 7 Construction _.
-+ 8 Transformatic_
{39 Seftings... y<

WoNOVE I WNES

Point On
Intersection Point(s)
Line

Segment

Ray

Tangent

Vector

Circle arc

Another option available is the Geometry page,

which is restricted to plane geometry. Some of the

menu options are shown above.

There is no grid or axes available on a Geometry

page but an analytical Geometry page can be

inserted.

Handheld Status

Batteries: 100% [E
VEIS!OI\

Storage Capacity: 92.3 ME
Storage Available: 88.0 MB

Login: Not logged in,

About

Network: Wireless client is not attached.
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Casio ClassPad introduction

The latest model of the Casio ClassPad is the fx-CP400.
The connectivity software Screen Receiver, Share

Assistant and Program Link Software can be
downloaded for free. The ClassPad Manager
software emulator is a separate program

available at an additional cost.
=] .

:hnl

Plcture rg Inurlctlvu

Plot DiffCalc
{2 conles ] n"'“ﬁq'

Casio ClassPad

Student book instructions
The instructions in this student book use words instead of _

symbols. ClassPad tools are located at the top of the screen. These | graph 3
tools vary with each application. Initially, these instructions will
show a tool enclosed in a red rectangle with the corresponding

View Window o)

Table
word highlighted in red. Examples are shown here:
Table Input Ll
Applications
The applications available are outlined below.
MENU © MENU ©
SN [o M Main L = NumSolve Sequence
Actlvity Statistics !:'—' Financial @Prwmm
oo Commu~
2 Bl | [l
Gaomatry . Physlum
Pletu I ti
.}.z( ") Bl
COnh:s ’ ] glrf'prhq-
o ==
Tap Menu to view the applications. Slide the scroll bar at the bottom of

the screen to access the full list.
9780170448260 Casio ClassPad introduction XXi



Menus

The instructions in this student book will primarily use the Main, Statistics, Geometry, Graph&Table and
Conics and applications (see Applications on page xxiv). All of these applications have the ¥ (system)
and Edit menus available at the top left of the screen.

Edit Action Interactive o ”At;rtlon Interactive

Variable Manager  |[fax, |y [ 111 | %, | Undo/Redo ‘ vty

View Window | Cut

Basic Format L iCopy

Graph Format | Paste

Geometry Format | Select All

Advanced Format | Delete

Financial Format |Clear All Variables

Default Setup | Clear All

Main

 Keyboard
Tap ## to view the system menu. The menu Tap Edit to view the edit menu. The menu options
options allow you to manage variables and allow you to cut, copy, paste and delete screen
format applications. content and clear variables. The Edit menu varies

with each application.

Document Settings

Basic Format Basic Format
| Current Folder Current Folder
| main [v | main [
Number Format Number Format
| Normal 1 [+] Fix 3 [+
Angle Fix 0 B ‘
[ Radian [v Fix 1 -
Fix 2
Advanced :
Complex Format @ |
. X
Decimal Calculation Fix § v
[ ] Assistant Assistant
|V Descending Order |V Descending Order
[ 1Variable is Real [ 1Variable is Real
1Qy, Qs on Data [_1Q4, Qg on Data
I Set | I Cancel ] I Default ] I Set ] ’ Cancel I I Default ]
Alg  Stendard  Real Red Alg  Standard  Real Red @
Tap #¢ > Basic Format. The screen above shows Tap the Number Format field to display the
the default document settings. The Number options. The screen above shows the Display Digits
Format default field is set to Normal 1. options. Scroll down to fix a specific number of

decimal places.

The settings Standard/Decimal, Real/Cplx and Rad/Deg/Gra can be toggled at the bottom of the screen.
The recommended settings are Standard, Real and Rad.
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Keyboard

There are 9 soft keyboards available.

| Math! [Line| ™ [ vl [ = | »
| Math2 | | o | loggl| VO
‘ MathS | X2 x-! |0£m(l) solve(
| T8 | g obms =] | O
| Vvar :
abe sin | cos |tan | ° ’
4.\%4% ans[EXE’

Alg Standard Real Rad {10

Press Keyboard to view the soft keyboards. The
Math1 soft keyboard is shown above with the
simultaneous equation template highlighted in red.
Tap the left tabs to access the other keyboards. Press
the down arrow to view the second screen.

Math1 “ Line| = | ym | = >

MT“I“:" il [E0] &0 [/ b

v’: (oacn | (=1 /(28] | B= | §=
| sin [cos |[tan | @ | 2

abc | e

" Tv |+ [Fa [ G [ons [ |

Alg Standard Real Deg (i

Tap Math2 to display the soft keyboard. The
derivative and integral templates are highlighted

in red.
Math1‘ a | blc|d|lelf
LA
Math3 || 1 1
fm | n | o | p|lq|r
Trig | |
\ S t |\ v w| x
Var :
¥ |2 |C)] . | & |caes
abc [
T+ [ % | G | ans [ Exe |
Alg Decimal Real Deg ({10}

Tap Var to access the variables. Use variables,
not letters, in your algebraic calculations.

9780170448260

Catalog | [a[B[c|D[E[F[»]
Advance Ry Form
(Number || 2t [ ‘M‘

:%Epr
ol i g e |
Alg VDecimal Real Deg

All functions can be accessed from Catalog. Tap
on the letters at the top to jump through the list.
Press the up arrow to return to the first screen.

=
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(2]
=]
Q
(e)
[+ <
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=
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N
(7))
g
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o
=
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Mathl | jine| ™= | ym | = | »
Math2 Ipeine| £ | g | i | o
M:t'h?] solve(| dSlv | |{g;g |
SLUH v S T K i
Var T
=< = = £ Z
abc || : !
T« [ % |G s o]
Alg Standard  Real Rad (il

The Math3 template is shown above with the
piecewise template highlighted in red. Use this
keyboard for inequalities.

sic | aBy | Math | Symbol |
1/2(3|4|5(6|7|8|9|0]|=-
qwelrtyuiop@

als|d|f|(g|h|i|lk|]l]:

#lz|x|c|v|b|n|m|, |. s
=]+

Alg Decimal Real Deg

Space ‘ EXE ‘

Tap abc to access letters and symbols. Use letters
to name functions and matrices etc. Tap the tabs
at the top of the screen to access the range of

symbols. Press back to return to the main screen.
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Applications
Main

& Edit Actlonﬂ

%1 -\il... fixq| Transformation

e Advanced

o Calculation
Complex
List
Matrix
Vector
Equation/Inequality
Assistant
Distribution/Inv. Dist
Financial
Define

v v Y WY WY WY W w w w w

In Main, there are two menus available to enter
functions: Active and Interactive. With the
Interactive menu, users are prompted with a
dialogue box to enter the parameters. With few
exceptions, the instructions in this student book
are written using the Interactive menu.

For derivative and integral, it is easier to use
Interactive > Calculation > diff or summa (J) rather
than the icons in Math2.

Nelson VICmaths Mathematical Methods 11

& Edit Action Interactive
reii%l\”'\’l{:i::] Simp J‘_l‘/ v J\-{-"— VTT

Define f(x)=2+x+3

done
f(2)
7
5»a
5
1]

m l..ine; - ‘ = ]

To define a function, enter and highlight the
expression then tap Interactive > Define. The store
arrow is available from the Math and Trig soft
keyboards. Store can be used to store values.

Use the abc soft keyboard to label values.
All algebraic working uses Var and not abc.

Define a function will be over-saved with a new
defined function.

In contrast, store variables need to be cleared
using Variable Manager.

9780170448260



Graphing

There are two main options for graphing functions and relations.

& Edit Action Interactive & File Edit Type o

I s
't & [1a ] sime

f(x) ] Sheet1 [Sheet2 Sheetd |Sheetd [Sheet5 |
2.x+3 01 M y1=2-x43 —
y3:0 ;
va:0
v5:0
vB:l

&

=
o
=
(2]
=]
Q
(e)
[+ <
=
=
<
o
N
(7))
g
wd
o
=
(7))
<
o

3456 7x
: LY
Alg Standard  Real Red
In Main, tap Graph to open the graph window. Graph&Table is used much less frequently because
Enter and highlight the function or expression it requires rearrangement in terms of y = ...
and drag it into the Graph window from either Tap Menu > Graph&Table. Enter the function
the right or left side. then tap Graph. The instructions in this student
If the function has a restricted domain, it must book use the Main option in preference to the
be dragged from the left side of the screen. Graph&Table option.

The significance of Main is that the algebra is on
the top and matching graphs are on the bottom
of the twin screens.

& Edit Zoom - [X] & Edit Zoom |Analysis| ¢ [x]
Y Ll | E=i=9| Trace IE vl R R Eg | Trace kX -@_‘ | -
= Cls m_ﬁj———— ————=_—— [T -
Plot |G-Solve * x-Cal/y-Cal  »
Line | Modify | Modify |Root
Text Min
| Tangent S E T TS50 g
Normal fMin
Inverse fMax
Circle y-Intercept
- Vertical Intersection
= Horizontal [T % , . Integral ’
LX) J f(x) Inflection
2:x+3 Distance
x2_4 ‘ x2_4 rff(x)2dx
There are several menu options available to analyse  Tap Analysis > G-Solve to identify key features
graphs. Tap Analysis > Trace and press the arrow of a graph. For example, select Root to find the
keys to move along the graph. Tap Analysis > x-intercepts and select Intersection to locate
Sketch for the options shown above. points of intersection of two graphs. G-Solve gives

decimal values. Use Main to calculate exact values.
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Statistics

# Edit Calc SetGraph ¢
e vl o 9
list 1 list2  [list3 0
1 1 0.1 [l
2 2 0.2 »
3 3 0.8
4 4 0.3
5 5 0.1
6 e
7
8
9
10
11

Tap Menu > Statistics to open the Statistics
application. The default settings show list1, list2,
list3, etc. If required, tap on the list name to enter

a new heading.

Set StatGraphs
1[2]sf4]5[6[7[8]9]
Draw: ©0on off

e [HistGgERT v
XList: [ list1 [¥]
Freg: [ listz [v]

Tap SetGraph to set up the statistics graphs. Tap

Type: to view the graphing options for statistical
graphs. When finished, tap Set.

& File Edit Graph Calc

HBE06E ML A

A B | €

1 1 1 =
2| 2 4

3 3 )

| 4 | 4 16|

5 5 25|

8 6 36
L 7 49

8 8[54 ’
9
(10

11 \

12 \

13 \

14 |

15 \ ;
|16 | l (v
O |
=A8"2 [v[X]
B8 64

Tap Menu > Spreadsheet to open the Spreadsheet
application. Values and formulas are entered using
standard spreadsheet techniques. Column A shows
the numbers 1 to 8 and Column B shows the square
of the numbers.
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Stat Calculation %] t
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X

I
)
|

|
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25,
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L 1
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1.1357817
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{minX =

|
24

Med =
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Tap Calc to view the Calculation menu options.
Tap One-Variable for the dialogue box used to
calculate statistical analysis of a list. The screen
above displays the one variable statistics for list1
for the frequencies in list2.

# Edit Calc SetGraph ¢

By | Oy

Tap Graph to display the statistical graph.
The graph above displays a histogram of the list1
values for the frequencies in list2.

& Edit View Type Calc (x
o AR
1 A B c Ei
1 1 1 =
[2 2 A A ‘
[ 3 3 9
4 4 16
| & 5 25
| 8 §| 36 -

Highlight the required data and tap Calc to access
the range of statistical functions.

Highlight the data and tap Graph to access the
range of graphs available. The graph above shows a
Scatterplot of the squared values.
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Geometry

£ File Edit View Draw

(%]

Tap the Grid tool to toggle through the various grid
options. The other tools at the top of the screen can

also be accessed by tapping on the Draw menu.

Tap the basic object down arrow to view the objects.

Select the circle object. Tap a centre and another
point to draw a circle.

& File Edit View Draw
f— Iv19. 433981 [nh <
4 5 B
A
X+y= !
C /
A2 /
= 7 1
A
C
-5/
G

Tap to highlight an object then tap the down arrow
to view the measurement box options.

The length of the line is shown at the top of
the screen.

9780170448260

& File Edit View Draw

_0O% EOESgEC

9

=
Select the line segment object then draw
segments.

To measure or find equations of objects, tap the
right arrow to view additional tools.

& File Edit View Draw
A | v134.7652

2aE

RIEDE
N

Tapping two objects gives different measurement
box objects.

The angle between the line segments is shown at
the top of the screen.

Tap the left arrow to return to the first screen.

Casio ClassPad introduction
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Xxviii

Operating systems

Ensure you have the latest operating system installed on your

handheld.

Tap Settings (located in the bottom left corner of the screen) then
select Version. At the time of publication, the latest version is
02.01.7001.

To download the latest operating system, go to the Australian
Shriro website at http://www.casio.edu.shriro.com.au/classpad.
php. Using the USB cable provided, connect the handheld to a
computer. Start the installation program and follow the prompts.
Some of these prompts will be on the computer and others

will be on the handheld.

Nelson VICmaths Mathematical Methods 11
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Algorithms and pseudocode

Algorithms

An algorithm is a set of instructions for successfully completing a task. The success of activities such
as baking a cake, finding your way through a maze and mowing the lawn relies on executing a defined
sequence of steps that produce the desired outcomes. If the algorithm is efficient, the cake will be
delicious, you will find your way out of the maze and the lawn will be cut evenly.

An algorithm can be a set of instructions using everyday language, a flowchart or pseudocode.

Flowcharts

A flowchart uses a prescribed set of symbols to display the instructions of an algorithm.

) [ ] —

start/end process decision input/output direction connector

| Ve 4= N B S B Flowchart design for lighting a match

Draw a flowchart to show the following steps in the algorithm to light a match.

+ Open the match box.

+ Take out a match.

o If the match is used, take out another match.

+ Scratch the match against the striking surface.

+ If the match doesn’t light and there is another match, repeat the method above.

Steps Working

1 Use a start/end Use a process symbol to ‘take out a match’

symbol and
perform the (st )

first instruction.

Take out a match

2 Show the decisions  Use decision boxes to decide what to do if the match is used, the matchbox is
to be made aftera  empty or if there is no other matchbox.

match is taken out.

Take out a match

Is there
another
box?

9780170448260 Algorithms and pseudocode  XXix



XXX

3 Complete the Show what happens after the match is struck.

flowchart. Ensure that lines with arrows point in the right direction and connect to the
appropriate sections of the flowchart.

Start

Take out a match

Strike the match

Is there
another
box?

no

VL) s 2 N B - Interpret a flowchart

The flowchart below describes an algorithm.

set the count to 0
set the sum to 0
set L to 4

1

Increase the count by 1 <

Input the next
number, N, from new sum = old sum + N
the list

Divide the new sum by L

/ Output the result /

a State the values for count, sum and new sum when N=25, 6, 1, 8.

b Describe what the algorithm is calculating.

Nelson VICmaths Mathematical Methods 11 9780170448260



Apply the flowchart instructions for
the first value of count.

2 Follow the correct path for the decision.

3 Repeat the loop until the count value
is greater than the N value.

4 Follow the final set of instructions
prior to terminating the program.

Steps Working

a 1 State the initial values. count=0
sum =0
L=4

count is increased by 1, so count=0+1=1.

The count (1) is not more than L (4), so the first
number from the list (5) is used. This value is added
to the value of the sum, so the new sumis 0+ 5 =5.

count=1+1=2
N=6,sum=5+6=11
count=2+1=3
N=1,sum=11+1=12
count=3+1=4
N=8,sum=12+8=20
count=4+1=5

count is more than L, so follow the ‘yes’ path at the
decision box.

finalsum=sum+L=20+4=5

The outputis 5

b 1 Describe the situation by looking at
what happens in the process symbols.

2 State the conclusion.

For each value of the count from 1 to 4, a number,
N, is taken from the list and added to the previous

sum.

In the final step, the sum is divided by how many

numbers were used.

The algorithm finds the arithmetic mean of a given
set of 4 numbers.

Pseudocode

In Worked example 1, a set of easily understood instructions were used to create a flowchart describing

how to light a match. In a similar way, pseudocode consists of a combination of technical terms and

commonly used words that provide an informal but effective way of depicting the flow and operation of

a task. Think of pseudocode as the ‘planning’ stage that guides how the actual computer program will be

developed. Because it is not tied to any specific programming language, pseudocode allows flexibility in

choosing words and phrases. However, by adopting a number of conventions, a better understanding of

the basic operations required to accomplish the task can be achieved.

The following are commonly accepted practices.

+ Keywords and commands are capitalised.

+ One statement is given in each line.

+ Indent sections that are used to convey a specific task.

9780170448260
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Below are the main commands that will be used with pseudocode.

INPUT INTEGER Name(size] [F (a given statement is
read data Reserves size + 1 locations to store true)

values. THEN (perform action 1)
OUTPUT/PRINT A « B (A is assigned the value of B) ELSE (perform action 2)
print data ENDIF
DO FOR variable = first value TO last value REPEAT
<procedure> <procedure> <procedure>
WHILE (condition is true) ENDFOR UNTIL (condition is true)
ENDWHILE
+ addition < less than
— subtraction > greater than
/ division <less than or equal to
* multiplication > greater than or equal to
" power

| Ve = S N B S Interpreting pseudocode

a Describe what the program
INTEGER array[10]
count <~ 0
FORloop=1TO 10

IF loop MOD 3=1

THEN
count ¢— count +1
array[count] < loop
ENDIF
number[count] <— number

ENDFOR

FOR numeral =1 TO count
PRINT number[numeral]
ENDFOR

PRINT “The sum of the 10 numbers is”

below is doing.

line 1
line 2
line 3
line 4
line 5
line 6
line 7
line 8
line 9
line 10
line 11
line 12
line 13
line 14

b State the output for each cycle of the PRINT command.

XXXii
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Steps Working

a Describe what is happening in An array to store up to 11 numbers is initialised. (line
each section. 1)

A counter is set to 0. (line 2)

Aloop consisting of the numbers 1 to 10 is used.
(line 3, 10)

Each of the numbers 1 to 10 is divided by 3 and if the
remainder is 1, the counter is increased by 1 and the
number is stored in the array. (lines 4 —9)

A descriptive heading for the output is printed. (line
11)

The numbers which have been stored are printed.
(lines 12 —14)

b 1 Show the output from the first Line 11 prints the output heading, The sum of the
PRINT statement. 10 numbers is
2 Write the output from the second From line 13, the numbers to print are numbers from
PRINT command. 1 to 10 which have a remainder of 1 when divided by 3.

These are 1, 4, 7 and 10.

‘WORKED = VB Pseudocode involving addition of numbers

Write pseudocode that finds the sum of 10 numbers and prints the result.

Steps Working
1 Initialise the sum of the numbers There are 10 numbers to read, one at a time.
and set up a loop to read the numbers. current sum < 0

FOR count=1TO 10
INPUT next number from list

procedure
ENDFOR
2 The procedure keeps a running total current sum < 0
of the numbers. FOR count=1TO 10

INPUT next number from list
current sum <« current sum + next number from list

ENDFOR
3 Print the result. PRINT “The sum of the 10 numbers is”
PRINT current sum

9780170448260 Algorithms and pseudocode  xxXiii
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VL) (=0 2 GV B S8 Pseudocode using random numbers, modulus, product

The function A MOD B returns the remainder after A is divided by B, for example, 8 MOD 3 = 2.
The function RAND(A) generates a random whole number from 1 to A, for example, RAND(5) = 3.

Write pseudocode that generates 3 random even numbers from 2 to 10 and then finds their product.

Steps Working
1 Initialise the product of the numbers and There are 3 random numbers to generate.
create a loop for the random numbers. current product « 1

FOR count=1TO 3

procedure
ENDFOR
2 Check to see if the random number A number is even if the remainder after division
is even. Print the even number. by 2 is 0.

current product «— 1

FOR count=1TO 3

REPEAT
random number <— RAND(10)
remainder <— random number MOD 2

UNTIL remainder =0

PRINT random number

ENDFOR

3 Update the product and output the result. current product <— 1

FOR count=1TO 3
REPEAT
random number <~ RAND(10)
remainder <— random number MOD 2
UNTIL remainder =0

PRINT random number

current product <— current product * random number

ENDFOR

PRINT current product

xxxiv Nelson VICmaths Mathematical Methods 11 9780170448260
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Study Design coverage

UNIT 1, AREA OF STUDY 2: ALGEBRA, NUMBER AND STRUCTURE

e use of symbolic notation to develop algebraic expressions and represent functions, relations, equations,
and systems of simultaneous equations

e substitution into, and manipulation of, these expressions

e recognition of equivalent expressions and simplification of algebraic expressions involving different forms
of polynomial and power functions, the use of distributive and exponent laws applied to these functions,
and manipulation from one form of expression to an equivalent form

e solution of a set of simultaneous linear equations (geometric interpretation only required for two variables)
and equations of the form f(x) = g (x) numerically, graphically and algebraically.

Note: The bisection method is covered in Chapter 3, Polynomials.
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Video p[aylists (9): 1.2 Binomial products ¢« Special products
1.3 Factorising algebraic expressions

1.6 Changing the subject of a formula
1.7 Simultaneous equations
1.8 |Inequalities on a number line

* Inequalities review
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11  Index laws

1.2 Binomial expansions

1.3 Factorisation

1.4 Equations

1.5 Quadratic equations

1.6 Changing the subject of a formula

1.7 Simultaneous equations 1.4 Equations code puzzle
1.8 Inequalities 15

Factorising quadratic equations * Complete the
square order activity * The quadratic formula

Worksheets (9): 1.7 Simultaneous equations order activity

VCE question analysis Equations and inequalities

11 Review of index laws ¢ Fractional indices
and radicals

To access resources above, visit
cengage.com.au/nelsonmindtap

o¥Nelson MindTap

@ Index laws

In the term a", a is the base and # is called the index or the exponent. Index laws for simplifying
index expressions are listed below. These laws are easy to understand if we use the definition

ad'=axaxaxax...(ton factors)

For example, 2° =2 X2 X2 X 2 X 2 = 32,

The index laws

am % an = am+n aO =
m , n _ _m-n — 1
a +~a4da =a a = —
) a"
(am) = g™ i
n aq =4 &
(ab)" = a"b"
£ P
[
aY a" aq = IaP = (%)
b

9780170448260 Chapter 1 | Equations and inequalities
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wB

p.1

p.-2

Using the index law (ab)" = a"b", the expression (3xy)* = 9x%y%.

Using the index law a™ + a"

m—n . a+1
=a ,theexpression x

2 —a+1
+xP=x"

2

p
» , 2 s
Using the index law a’ = ¥a” = (% ) , the expression 273 becomes /27> or (3 27) =9.

'woRKED EXAMPLE 1 [
2

Simplify the expression a® x a® x b® x b™° + a’.

Steps

Working

1 Write the expression and group the terms with
the same base.

2 Use index laws to simplify.
3 Simplify indices.

a®xa®xb¥xv?+a?

=a®xa®+ > xb¥x b’
582y 89

127-1
=ab

@ Exam hack

It is not necessary to express your answer with positive indices unless specifically asked in the question.

WORKED EXAMPLE 2\ [1[¢[-) ¢ =\

1 3 2 1

Simplify the expression 8% X 164 X 5% + 53.

Steps

1 Write the expression and simplify the bases to
prime numbers if possible.

2 Use index laws to simplify.

Working
1 3 2 1
83 x 16% x 53 + 53
1 3 2 1

= (2P x (2*)4 x 53 + 53

t ¢

( Write 8 and 16 as powers of 2 to simplify. J

1 3 2 1
3IX— 4 X —— -
=2 3¥3x2 4x5%3
1
=2'x2’x 53
1
=24x 53

Exponential equations

An exponential equation is an equation in which the variable is in the exponent (power). Exponential

equations can be solved by using index laws to express all terms with a common base. The base chosen is

usually a prime number.

Nelson VICmaths Mathematical Methods 11
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VL) = o G B B F Exponential equations
Solve the equation 3% x 3' 7% = 9* for x.
Steps Working
1 Express each term with the base 3 and 37 x 31T =9"
Y R B s
simplify using index laws. 32eH1-3x _ (32 Write 9 as a power of 3'J
31 —x_ 32x
2 Equate powers. 1-x=2x
3 Solve for x. 1=3x
1
x==
3
EXERCISE 1.1 Index laws ANSWERS p. 491
wB
Mastery
p.3

1 workeo exavpLE 1| EEESEETES Simplify the expression a® x b® + a’.

1 3 1 1

2 WORKED EXAMPLE 2 | Simplify the expression 273 x 164 + 84 + 24,

3 Simplify each expression.
a 32%x2x16" b 32°x 8" x16* c 2% x8%x16™

d a’x2a’x 164> e bxb xb¥ f a¥xa¥xa”™

4 [ =9:0di=5 Simplify each expression.
a a+2a’ b b™+0b* c a*+a”

d 3*+27° e 2¥+07™ f 47 +16%

5 [ workep exaveLe s | The solution to the equation 2% x 2' 3 = 4% is

A x=-1 B x=—- C x=1 D x=2 E x=4
3 2 3

6 The solution to the equation 3* ! x 9% = 27" is

1
A x=-1 B x=—l C x=0 D x=— E x=1
2 2
1 1
7 The value of 92 x 812 is
A 3 B 9 Cc 27 D 81 E 729

1
8 The expression ab x (4ab)? + (ab)’ is equivalent to

1 3 Jab 1 2
A (ab)? B 2(ab)? c Y» D — Z
(ab) (ab) ab Jab Jab

Exam practice 80-100%  60-79% 0-59%

9 85% [LZSiN5 (2 marks) Solve the equation 277 = 8% * for x.
10 76% [[ISE155 (2 marks) Solve the equation 37 = 9%~ for x.

9780170448260 Chapter 1 | Equations and inequalities 5
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Video playlist
Binomial
expansions

Worksheets
Binomial
products

Special
products

11 The expression b° x (2b)° + b can be simplified to
A 20" B 2b" c 2%* D 2'%" E 2%"
r2 2
12 The expression 63 X 33 x 25 can be simplified to

2 2 7 11 11

A 6x25 B 3x25 c 25 D 3x 215 E 215

13 The solution, for x, of the equation 9 x 3** = 27*** 2 s

A x=0 B x=5 C x=1 D x=3 E x=6
14 The expression ab®x (2a)’ is equivalent to
A 24%D° B a'b’ c 2’ D 2°ba® E 8a'h’
1 2 2

15 The expression 83 X 83 + 325 is equivalent to

2 2
A 3'x25 B 12 C 8+ 25 D 32 E 8 x2?

16 The solution, for x, of the equation 3% 3°=271is

A x=1 B 3'=1 c x=§ D x=3 E 37=1
17 The expression b° x a® + a’ can be simplified to
A a' B a’ c va D b E b
o3 1
18 The expression 81* x 94 H 3% canbe simplifiegi to
A3 B 3¢ c 3¢ D 3° E 3°

@ Binomial expansions

Binomial products

A binomial expression is an expression with 2 terms, for example, x + 4 and 3x* — 6.

A binomial product is the product of 2 or more binomial expressions, such as (3x + 2)(x — 1).

It has the form (a + b)(c + d).

To expand (a + b)(c + d), we can use the following distributive law:
(axc)+(axd)+(bxc)+(bxd)=ac+ad+ bc+bd

This method can also be remembered using the letters of the word FOIL.

FOIL method

First terms, Outer terms, Inner terms, Last terms

FE O

Ifd tly, the O and I t
(m) =ac+ad + bc+ bd one correctly, the O and I terms
~— are like terms that can be collected.

L

When a binomial product such as (3x +2)(x — 1) is expanded, the simplified answer usually has 3 terms,
such as 3x* —x — 2.

This is called a quadratic expression, where the highest power of x is 2.

Nelson VICmaths Mathematical Methods 11 9780170448260



MORKED = ¢\ B8 Binomial expansions

Expand and simplify the expression (x — 5)(2x + 1).

Steps Working

Use the distributive law to expand (x — 5)(2x + 1). (x=5)2x+1)=x(2x+1)—52x+1)
=2x*+x—-10x—5

=2x"—9x—5
Or use the FOIL method
First: x X 2x = 2x° (x—5)(2x+1)=2x>+x—10x—5
Outer: x X 1=x > =2x*-9x-5

The O and I terms can be collected to
Inner: =5 X 2x=~-10x | give the middle term: x — 10x = —9x.

Last: -=5x1=-5

m Binomial products wB

Expand the expression (x — 5)(2x + 1). p.4

% Edit Action Interactive

e[ [afsm] o [ [

J

expand((x-5)- (2 x+ 1)) 2: x2-9:. x5 expand ( (x-5)+(2+x+1)) 4]
2:x2-9ex-5 '
1 Add a Calculator page. 1 In Main, enter the expression (x — 5)(2x + 1).
2 Press menu > Algebra > Expand. 2 Highlight the expression and tap Interactive >
3 Enter the expression (x — 5)(2x + 1). Transformation > Expand.
4 Press enter. 3 Tap OK.

Perfect squares

(a+ b)* and (a — b)* are special types of binomial expansions called perfect squares, which have their

Perfect squares

(a+b)*=a’+2ab+ b*
(a—b)*=d>=2ab+ b*

Ve i S N B S Perfect squares E

own formulas.

Expand the expression (x + 5)2,
Steps Working p-5
Use the distributive law or the FOIL method to (x+5)*=(x+5)(x+5)
expand (x +5)". =x"+5x + 5x + 25
=x*+10x+25

OR use the formula (x+5)*=x*+2XxX5+5
(a+0b)*=a*+2ab+ b~ =x*+10x + 25

Note the pattern:

o st term squared

o last term squared

o twice the 1st multiplied by the last

9780170448260 Chapter 1 | Equations and inequalities 7
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Difference of two squares

(a+ b)(a— ) is another special type of binomial expansion involving the sum of 2 terms multiplied by the

difference between the same 2 terms. This type is called difference of two squares, because the expanded

form is the difference between 2 square numbers a” and b,

Difference of two squares

(a+b)a-b)=a*- b

(This is also called ‘difference of perfect squares, abbreviated to DOPS. J

MORKED - ¢\ |JJE = Difference of two squares

Expand the expression (2x + 5)(2x — 5).

Steps Working
1 Use FOIL method to expand (2x + 5)(2x — 5). (2x+5)(2x — 5) = 4x*> — 10x + 10x — 25
=4x>-25
2 Alternatively, use the difference of two squares (2x+5)(2x — 5) = (2x)* — 5
formula (a + b)(a — b) = a* — b". — 4,225
EXERCISE 1.2 Binomial expansions ANSWERS p. 491
Recap
1 Solve the equation 2% x 2** = 2" ! for x.
2 The solution, for x, in the equation a* x a* "' = a* is
A x=a' B x=E (o x=3 D x=3 E x=4
3 2
Mastery

3 Expand each expression.
a 2(2x+3)
c (x+2)(x-3)

b 4(2x-3)
d (3x+2)(2x+3)

4 [ WORKED EXAMPLE 4 | Expand and simplify the expression (x + 5)(x + 1).

5 Expand and simplify the expression (2x +5)(2x + 1).

6 Expand and simplify each expression.
a (x+1)(x-1) b 4(x+1)(x—1)
d 32x+1) e 4(—x+1)

7 Expand each expression.
a (2x-7)(3x—-9) b (2x—3)(3x+38)
d (7p+4)(7p—4) e (x+2)(2x—-3y+7)

Nelson VICmaths Mathematical Methods 11

c (x+3)(x-3)
f —4(2x—3)?

¢ (m—>5n)
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8 The expression (2x — 5)(2x — 1) can be simplified to
A 4xX°+12x+5 B 4x’—12x-5 C 4x"—12x+5
D 4x*+12x-5 E 2X°—10x+5

9 WORKED EXAMPLE 5 | The expression (2x + 3)? can be expanded as
A 4x°+9 B 4x" -9 C 2 +3
D 4xX*+12x+9 E 4X+6x+9

10 WORKED EXAMPLE 6 | The expression (4x + 3)(4x — 3) can be expanded as
A 4 +9 B 4x"—9 C 16x*-9
D 4x +12x-9 E 16x"—24x+9

Exam practice

11 The expression (3x — 5)(2x + 7) can be expanded as
A (3x-5)2x+7) B 3x(2x+7) C xX*+11x+35
D 6x°+11x—35 E 3x°+11x+35

12 The expression (3x — 5)* can be expanded as
A (3x—5)(3x+5) B 9x°—30x+25 c x*-25
D 9x° 25 E 9x°+30x+25

«l
- - '
(+s) Factorisation
Video playlist
Factorisation
Factorising is the opposite of expanding. While expanding involves removing brackets and multiplying
terms, factorising involves inserting brackets and ‘taking out’ common factors. ‘é\’“tkS!’?e;
Examples of factorisation are: Bt
e 3x+12=3(x+4)
o 3x%+12x=3x(x+4)
o 6x*—12x=6x(x—2)
o 4P+ 12x+16=4(x*+3x+4)
Perfect squares
VL) 2 O B B2 Factorising perfect squares WE
Factorise the perfect square 4x* — 20x + 25.
p.7

Steps Working

Use the formula (a — b)* = a* — 2ab + b* in reverse,  4x” — 20x + 25 = (2x — 5)°
where a =2x, b=5.

[
Note the pattern:

o square root of the 1st term
o square root of the last term

Then check that the middle term is twice the
Ist multiplied by the last.

J

9780170448260 Chapter 1 | Equations and inequalities 9
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Difference of two squares

i

o) =00 5 OV | B R Factorising the difference of squares

Factorise the expression 4x* - 25.

Steps Working
Use the difference of two squares formula 4x* —25=(2x)* -5
(@a+b)a-b)=a’-b = (2x+5)(2x - 5)

In the expression 4x*—25,a=2xand b=5.

Grouping in pairs

If there are 4 terms to factorise, then consider grouping in pairs. That is, factorise the first 2 terms, then the
last 2 terms. Sometimes, a common factor will appear.

Ve = SN RSB Factorising by grouping in pairs

Factorise each expression.
o =40 txr 1 sl o g o
b 2x°—4x+x-2
Steps Working
a 1 Factorise the first 2 terms, then the last 2 terms. X —4x* —4dx+16=x*(x — 4) — 4(x — 4)
2 Factorise again using the common factor (x — 4). =(x—4)(x*—4)
3 Factorise x° — 4. =(x—4)(x+2)(x—2)
b 1 Factorise the first 2 terms, then the last 2 terms. 2% —dx+x—-2=2x(x—2)+1(x—=2)
2 Factorise again using the common factor (x — 2). =(x-2)2x+1)
EXERCISE 1.3 Factorisation ANSWERS p. 491
Recap

1 Expand each expression.
(2x+3)(x+1)

42x—-3)(x+1)

(x+2)(x+3)

Bx+2)(2x—3)

O T o

[=%

2 The expression (x + 2)(x + 4) can be expanded as
A x*—6x-8 B x*+6x+8 C x*+6x—38 D x*—6x+38 E x*+38

Mastery

3 Expand the expression (x + 3)7.

4 P& WORKED EXAMPLE 7 | Factorise the perfect square x* + 10x + 25.

5 The expression (2x — 3)(2x + 3) can be expanded as
A 4x°+9 B 4x* -9 C 4x*—12x+9
D 4x’+12x-9 E 2x°—12x—-9

Nelson VICmaths Mathematical Methods 11 9780170448260




6 [c4 workep exavpLE s | [RIESIETIES Factorise each expression.

a 3x’+3x b 4x*—4x c —3x°—9x
d —3x*—9 e 3x°+6x+3 f 4x*—16x+ 16

g -9 h x¥*-16 i -y
i 3x-12 k 4x° — 16x I 2x*— 184
m x2—2x+1 n x2+8x+16 o 2x2+4x+2

7 WORKED ExAMPLE 9 | [RIZeiHF5155] Factorise each expression by grouping in pairs.

a —3x°—9x+3x+9 b 3X°+6x*+3x+6 c 4xX —16x*+4x— 16
d @’ —2ax*—9a°x+18a e 3x°—6x—6x+12 f xX*+x-3x-3
g X’ +8x—4x—32 h 2x°+3x—10x— 15 i 3x’+2x—15x— 10

8 Factorise each perfect square.
a 4x*+28x+49 b 4x*—12x+9 c m’+6mn+9n’

Exam practice

9 The expression (3x — 5)? can be expanded as
A (3x—5)(3x+5) B 9x°—30x+25 c x*-25
D 9x°—25 E 9x”+30x+25

10 The expansion of the expression (ax — 1)(ax + 1) is
A (ax—1)* B (ax+1)* C o +1 D ax’-2 E a’x*—1

11 The factorisation of the expression 9m” — 4 is
A B3m—-2)3m+2) B B3m+2)(3m+2) C 3m—-2)(3m-2)
D (3m—4)(3m+4) E (3m-2)°

12 The factorisation of the expression 9m” — 6m + 1 is
A Bm-2)3m+2) B 3m+1)3m+1) C Bm—-2)(3m-2)
D (3m—3)(3m+3) E (B3m—1)°

&
Video playlist
The solution to an equation is also called the root of the equation. To solve an equation, rearrange it using Fauations
inverse operations to get the variable by itself on the left-hand side (LHS). i :5:;(1; .
Solving linear equations
Solve 6(x +2) = 4x — 1 for x. =
Steps Working wB
1 Expand the brackets. 6(x+2)=4x-1 p. 10
6x+12=4x-1
2 Subtract 12 from both sides. 6x+12—-12=4x—-1-12
6x=4x—-13

9780170448260 Chapter 1 | Equations and inequalities 11



12

3 Subtract 4x from both sides.

6x—4x=4x—4x—-13

2x=-13
. . 13
4 Divide both sides by 2. X=- -

@ Exam hack

An improper fraction answer is preferred to a mixed number. Do not give a decimal answer unless it is asked for.

Factors, roots and x-intercepts

The roots of an equation are also the x-intercepts of its graph.

For example, consider the graph of y = 4x — 8.
o Solve4x—8=0togetx=2.

o The x-intercept of the graph of y = 4x — 8 will be x = 2.

For example, consider the graph of y = 2x* — 3x — 2.

 Factorise to get y = (x —2)(2x + 1).

x-intercept
(2,0)

o Solve the equation (x —2)(2x+1)=0togetx=2orx = —%.

« The x-intercepts of the graph of y = 2x* — 3x — 2 will be x = 2 and x = —%.

Y
4

y:2x2—3x—2

T T T T
-4 -3 -2 -1

_4_

NI

T
3 4 X

x-intercept

x-intercept (2,0

(~0.5,0)

MORKED = ¢\ JES5 B Roots of an equation

Find the roots of y = —2x* — 32x.

Steps Working

1 Factorise the expression —2x% — 32x. —2x% = 32x = —2x(x + 16)

2 Solve the equation —2x*—32x=0. —2x(x+16)=0
Sox=0,x=-16

Nelson VICmaths Mathematical Methods 11
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EXERCISE 1.4 Equations ANSWERS p. 491

Recap

1 [E505755 Factorise a*x® + ax? — 4a’x — 4a.

2 Factorise ax’ + 2x” — 9ax — 18.
Mastery

3 Expand the expression (x +2)°.

4 Factorise the expression x° — 3x* + 3x — 1.

5 [ WORKED EXAMPLE 10 | Solve 3(x + 3) = 2x — 3 for x.

6 [ WORKED EXAMPLE 11 ] Find the roots of y = x* + 9x.

7 The solution to the equation —2(x +2) =2x+ 5 is

A x=- 2 B x=-2 C x= é
4 9
D x=% 2 E x=5
4
8 The x-intercepts of the graph of y = 3x* — 9x are
A (0,0) B (-3,0) C (0,0)and (3,0)
D (0,0)and (-3,0) E (0,3)and (3,0)
9 The root(s) of y = —2x* + 8x are
A x=—4 B x=0 C x=14

D x=0,x=4 E x=0,x=14

Exam practice
10 (3 marks) Solve x” + (k + 1)x” + kx = 0 for x.

11 Part of the graph of a cubic polynomial function fand the coordinates of its stationary points are
shown below.

y_
(=3,36) 207
T I_I T T T I0 T T Ilsx
] [g —100]
o] B ¥
The roots of the graph are
A x=0,x=3 B x=0,x=3,x=§ C x=0,x=-3
D x=0,x=3,x=-5 E x=0,x=-3,x=5

9780170448260 Chapter 1 | Equations and inequalities 13



12 Part of the graph of the polynomial function fis shown.

g L 1)
. 3727
_E /‘\
-3 0 1 X
(72)79)
The x-intercepts of the graph are
1 1
A x=1,x=— B x=1,x=4%3 C x=1,x=-3,x=——
3 2
D x=1,x=3,x== E x=-3,x=1,x=—
. . 5.
13 The solution(s) to the equation =—1is
x+2 x
A x=-5 B x=-3 C x=—§ D x=3,x=5 E x=5

14 When 5x° — 2x — 7 is factorised, it becomes (5x — 7)(x + 1).
The root(s) of the equation 55— 2x—7=0are
7 7
A x=-1 B xz—g,x=1 C ng,xz—l D x=1 E x=5

15 The solution to the equation 3(y +7) =2(2y — 9) is
A y=-39 B y=-7 C y=3 D y=— E y=39

«l
o‘:

@ Quadratic equations

Video playlist
Quadratic
equations A quadratic equation is an equation where the highest power of the variable is 2, for example, 2x* — 9x —5=0.

l It has the general form ax” + bx + ¢ = 0, and can be solved by factorising, completing the square or using the
Puzzles

Factorising  quadratic formula.

quadratic

equations

wmeeve  Factorising quadratic expressions
activity
The quadratic  Quiadratic equations that can be factorised are solved using the null factor law.

formula
Null factor law

If ab =0, then eithera=0,b=0o0ra=b=0.

For example, solve the equation 2x* — 9x — 5= 0 for x.
(x—=5)2x+1)=0
x=5=0o0or 2x+1=0

x=5 or 2x=-1

1
x=5 or x=-——
2

14 Nelson VICmaths Mathematical Methods 11 9780170448260



A monic quadratic expression is one where the coefficient of x” is 1. We can factorise it using a ‘sum and
product’ method. First, notice the pattern when we expand the binomial product (x + a)(x + b).

(x+a)(x+b)=x>+bx+ax+ab
= x*+(a+b)x+ab
= x>+ (SUM)x + (PRODUCT)

MORKED = ¢\ |8 = 8 Factorising a monic quadratic expression

Factorise the expression X +3x+2.

Hence, solve the quadratic equation x* + 3x +2 = 0.

Steps Working

1 Write 2 pairs of brackets beginning with “x. CA3x+2=(x )x )

2 Find 2 numbers with a sum of +3 and a product 43x+2=(x+1(x+2)

of +2: they are 1 and 2.
Y @ Exam hack
(Look for factors of +2, pOSitiVe and negatiVe. J You can always check your answer by expanding it.
You may have been taught a different method of
1+2=3,1x2=2 factorising. Choose the method that suits you.
3 Solve the equation. K +3x+2=0

(x+1)(x+2)=0
x+1=0o0rx+2=0

x=—lorx=-2

A non-monic quadratic expression is one where the coefficient of x* is not 1. We can also factorise it using a
different ‘sum and product’ method.

Ve i 9 N B S B Factorising a non-monic quadratic expression

Factorise the expression 26 +x-3.

Hence, solve 2x* + x — 3 =0.

Steps Working

1 Find 2 numbers with a sum of +1 and a product ~ 2x* + 1x — 3 = 2x” + 3x — 2x — 3
of 2 X (-3) =—6: they are +3 and 2.

+3-2=+1,+3%x(-2)=-6
Use these numbers to split the middle term (+ x).

2 Factorise in pairs. =x(2x+3)—102x+ 3)
3 Take out the common factor (2x + 3). =2x+3)(x—-1)
4 Solve the equation. 26 +x-3=0

2x+3)(x—-1)=0
2x+3=0 orx—1=0

2x=-3 or x=1

x=——or x=1
2

9780170448260 Chapter 1 | Equations and inequalities
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Completing the square

If a quadratic equation cannot be factorised, the technique of completing the square can be used.

This involves writing the equation in the form a+2ab+b*=(a+b)lora’—2ab+b*=(a—-b)>.
To solve equations by completing the square:
1 Write the equation in the general form: ax* + bx + ¢ =0.
Take out the common factor of a.
Halve the coefficient of x and then square this number.
Add and then subtract (to compensate) the number found in the previous step.

Recognise the perfect square and factorise.

o G A~ O DN

Solve for zero to find the roots of the equation.

o) =00 9 N RS S Completing the square

i

Solve the equation 2x* + 12x = —1 by completing the square.

Steps Working

1 Write the equation in general form: ax* + bx + ¢ = 0. 26+ 12x =1
2 +12x+1=0

2 Take out the common factor of a. Z(x2 +6x + %) =0
3 Halve the coefficient of x and then square this Coefficient of x is 6.
number.

%of6=3and32=9

1
4 Add and then subtract the number found in the 2(x2 +6x+9-9+ 5) =0
previous step.
1
5 Recognise the perfect square and simplify. 2[(x +3 -9+ 5:| =0
7
2[(x +3) - 7} =0
2, 17
6 Divide both sides of the equation by 2 and solve (x+3)" - 5 0
for x. 17
(x+3)P="—"
2
x+3=% /z
2
x=-3% 1—7
2

The quadratic formula

The quadratic formula

For any quadratic equation ax® + bx + ¢ = 0, the solutions are

b+t Vb* — dac

=
2a

Nelson VICmaths Mathematical Methods 11
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To solve equations using the quadratic formula:
1 Write the equation in general form: ax® + bx + ¢ =0.
2 Identify the values of a, b and c and substitute into the quadratic formula.

3 Simplify where necessary (including the surd).

@ Exam hack

In most cases, the quadratic formula is easier to use than completing the square.

WL UGS IR Y Using the quadratic formula

Solve the equation 2x* = 2x + 3 using the quadratic formula.
Steps Working
1 Write in general form: ax® + bx + ¢ = 0. 26> =2x+3
2 —2x-3=0
2 Identify a, b, and c. a=2b=-2,c=-3
—(=2) £ (=2)" — 4(2)(-3
3 Substitute into the quadratic formula x= (22) £ ( 2(;) 2)3)
—b b’ -4
x=—2=N7 TR 0 simplify. _2%428
2a - 4
@ Exam hack 2127
Students often make mistakes in this last 4
cancelling step. 1+7
2
The discriminant
—bb’ -4
In the quadratic formula x = —ac’ the expression under the square root symbol,
a
b® — 4ac, has a special name: the discriminant, A. (A is the Greek letter ‘delta’.J

The discriminant, A, gives information about the number of roots of the quadratic equation,
ax* +bx+c=0.
o When A is positive, there are 2 roots.

o When A is negative, there are no roots because we cannot find the square root of a negative number.

o When A is 0, there is only 1 root because Jo = 0, so the rootis x = 2—
a

The discriminant for any quadratic equation ax” + bx + ¢ = 0 (where a, b and c are rational) is
A=b*—4ac.
» If A <0, the quadratic equation has no real roots.
o If A=0, the quadratic equation has 1 real root, which is rational.
o If A>0, the quadratic equation has 2 real roots.
- If Ais a square number, the 2 roots are rational.

- If Ais not a square number, the 2 roots are irrational (surds).

9780170448260 Chapter 1 | Equations and inequalities
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For the quadratic equation in the previous example, 2x* — 2x —3 =0

A=b*—4dac=(-2)"—4x2x(-3)=28

In this case, A > 0 and is not a square number, so the equation has 2 irrational roots.

Vet 2 LB S TS The discriminant

a Show that the quadratic equation 2x* + x + 4 = 0 has no real roots.

b Find the value(s) of k for which the equation 5x% — 2x + k = 0 has real roots.

2 Use the sign of the discriminant to explain

Steps Working
a 1 Write the discriminant, A = b* — 4ac, and A=b*—4dac
substitutea=2,b=1,c=4. —12-4%x2%x4
=-31

why the quadratic equation has no real roots.

Since A < 0, 2x* + x + 4 = 0 has no real roots.

b 1 Write the discriminant and simplify.

2 Make A > 0 for real roots and solve for k.

A=b*—4ac
=(=2)*—4x5x%xk
=4-20k

4-20k>0

akst
5

a Factorise the expression 6x° + 19x — 7.

b Solve the equation 6x* + 19x — 7 = 0.

m Solving and factorising quadratics

(2- x+7)- (3- X- 1)

factor(6- x2+19- x—7)

=7 1
Xme— OF X=m=
2

2
- -

solve(6- x2+ 19- x-7-0,x)

1 In a Calculator page, press menu > Algebra >
Factor.

2 Enter the expression 6x*+ 19x — 7 then
press enter.

3 Press menu > Algebra > Solve.

4 Enter the equation 6x® + 19x — 7 = 0,x then
press enter. Be sure to include ’,x’ after the

equation.

& Edit Action Interactive

el [l [ TO T

factor (6+x2+19+x-7)
(8+x=1)+(2+x+7)

solve(6-x2+19-x-7=0, x)

g3}

1 In Main, enter the expression 6x* + 19x — 7.

2 Highlight the expression and tap Interactive >
Transformation > Factor.

3 Tap OK.
4 Enter the equation 6x*+19x — 7 =0.

5 Highlight the equation and tap Interactive >
Equation/Inequality > solve.

6 Tap OK.

a 2x+7)(Bx—-1)

7
b x=——01rx=1
2 3

Nelson VICmaths Mathematical Methods 11
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EXERCISE 1.5 Quadratic equations ANSWERS p. 491

Recap @

1 Solve each equation.
a 2(x+5)=—4(x—2) b 2(x*—4)=x+2

2 The x-intercepts of the graph of y = x* — 4x are
A0 B Oand?2 CcC 2 D Oand4 E 4

Mastery

3 [ WORKED EXAMPLE 12 Solve each equation by factorising.
a kK+4k-5=0 b vV +2v-35=0 c xX’=9x—8

4 & WORKED EXAMPLE 13 Find the roots of the graph of y = 2x* + 5x — 3.

5 WORKED EXAMPLE 14 | Solve the equation x* + 6x = —1 by completing the square.

6 WORKED EXAMPLE 15 | Solve the equation 2x* = x + 3 using the quadratic formula.

7 WORKED EXAMPLE 16 |

a Find the discriminant of the equation 2x* = x + 3.

b Use the discriminant of the equation 2x* = x + 3 to find the number and type of solutions to the equation.
8 Show that the quadratic equation 2x* + 3x + 8 = 0 has no real roots.
9 Find the value(s) of k for which the equation 3x* — 2kx + 2k = 0 has 1 real root.

10 To complete the square in the equation x* + 6x + 1 = 0, we need to add and subtract

Al B 3 C 6 D 9 E 36

11 When solving the equation 2x” + 3x + 7 = 0 using the quadratic formula, the values of a, b and ¢ are
A a=2,b=-3,c=7 B a=2,b=3,c=7 C a=-2,b=-3,c=-7
D a=4,b=3,c=7 E a=2,b=3,c=28

12 The discriminant of 2x* + 3x — 7 is
A —47 B 23 C 59 D 65 E 137

13 The equation x*(x* — 81) = 0 has the solution
A x=0,x=-3 B x=0,x=9 C x=0,x=3 D x=3only E x=0,x=23

14 The equation x(x* — 81) = 0 has the solutions
A x=0,x=-3 B x=0,x=219 C x=0,x=9 D x=9only E x=0,x=%3

Exam practice 80-100%  60-79% 0-59%

15 (6 marks) Solve each equation.
a 3x*+5x—12=0 b 2x*—24x+22=0 c 3+ 15x+12=0

16 (6 marks) Solve each equation.
a X’+x-4=0 b 3x*—5x+1=0 c ¢"—4q-3=0

9780170448260 Chapter 1 | Equations and inequalities 19
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Video playlist
Changing the
subject of a
formula

Worksheet
Changing the
subject of a
formula

20

17 The expansion of the expression (3x — 5)% is
A (3x—5)(3x+5) B (9x—25)(9x +25) C 9x*—30x+25
D 6x°—16x+25 E 3x°+15x+25

18 The factorisation of the expression 3x* — 25 is

A (3x—5)(3x+5) B (V3x-5)(v3x+5) ¢ (v3x - 25)(v3x +25)

D (V3x-5)(V3x-5) E (3x—5)(3x—5)

19 The factorisation of the expression 4x” — 20x + 25 is
A (3x-5)(3x+5) B (4x-25)° c x*-25
D 2’ -5 E (2x—5)

20 The solutions to the equation 3x* — x — 2 =0 are

2 2

A x=-1,— B x=1, —— C (x—-1)(B3x+2)
3 3

D 3(x—1)(x+2) E x=-1,2

21 For the quadratic equation x* + 2x + p = 0, the values of p for which the function has 2 real roots are
A p<l1 B p>1 Cc p<-1
D p>-1 E p>0

22 - 7YY 2019 2402 MODIFIED | (59%  The values of k for which x* + 2x — k = 0 has two real solutions is
A k=-1lorl B k>-1 C k<-1 D k=-1 E k>-1

23 The values of k for which y = x* — 2kx + 8 has no real solutions are
A —2<k<2 B 22 <k<2V2 C 2V2<k<22
D —2<k<2 E k<242

24 The values of m such that the equation y = (1 + 1)x* — mx + 1 has 2 real solutions are

Am<22+2, m>2J2+42 B 2V2+2<m<2J2+2 C m<2y2+2, m>2J2+2

D m<2m2=2 E 2<m<?2

Changing the subject of a formula

A literal equation is an equation with more than one variable, such as ax + b = c. The most common literal
equation is a formula. We can rearrange a formula to make one of the variables the subject of the formula.

5
The formula for converting Fahrenheit temperatures to Celsius is C = — (F — 32). To make F the subject,
rearrange the formula so that F is on the left-hand side (LHS):

5
C=—(F-32)
9
9
—C=F-32
5
9
—C+32=F
5
9
S F==C+32
5
Nelson VICmaths Mathematical Methods 11 9780170448260



To make x the subject of a literal equation such ax + b = ¢, solve for x in the same way that a standard
equation, such as 2x +4 = 12, is solved for x. The only difference is that the final answer is a formula instead
of a value.
Forax+b=c

ax=c—b
_c—b

X =

a

Ve = S N RS A Literal equations

Make h the subject of the formula V= %nrzh.

Steps Working
Solve the equation for h. Rearrange using inverse le: ,
operations. V= 3 nrh
3V=mnr’h
£1%
“h=—
nr’

m Transposing formula

Make f the subject of the formula c = g (f—32).

& Edit Action Interactive
e[ or [eafsme o [ S|

isolve(c=—g--(f-32).f] (A

solve(c-% (f-32)f) f_')-Tc+32

1 In a Calculator page, press menu > Algebra > . . 5
Solve 1 In Main, enter the equation ¢ = ° (f—32).

2 Enter the equation ¢ = g (f — 32),f then 2 Highlight the equation. Tap Interactive >

press enter. > Equation/Inequality > solve.

3 Make sure you change the variable to f.

4 Tap OK.

EXERCISE 1.6 Changing the subject of a formula ANSWERS p. 491

Recap

:
a What is the discriminant of the expression m* — 6m + 92

b What does the discriminant of the equation m* — 6m + 9 = 0 show?

2 The solution for the equation 4x* — 6x +2 =0 is

A x=—l B x=0,—l C x=
2 2

N | =

1
2

9780170448260 Chapter 1 | Equations and inequalities
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Video playlist
Simultaneous
equations

Worksheet
Simultaneous
equations

Puzzle
Simultaneous
equations
order activity

22

Mastery

3 WORKED EXAMPLE 17 | Make r the subject of the formula S = 4ntrh* + 2.

4 Change the subject of the formula to the variable given in brackets.
a VzéAh (A) b S=§[2a+(n—1)d] (a)
c V=u’+2as () d Givenb>0,=a’+b> (b)

5 Make m the subject of the formula E = mc>.

E
A =mE B m=E C c=mE D m=— E m
c

e

4
6 The volume of a sphere is given by the formula V= 3 . An expression for r is

A r3—075V B r= 3[£ r= 3£ D r= ?/ﬂ E r=33—nV
T 4ar ar 4 4

7 Make c the subject in the formula E = mc?, given c is positive.

(9]

E m E

5 E E
A c"=— B c= — C c=— D ¢c=,— E c=—
m E m m \/E

Simultaneous equations are 2 or more equations with more than one variable. These are solved together

to give a set of values that satisfy all equations. Simultaneous equations can be solved algebraically or
graphically. Graphically, the solution is the point(s) of intersection of the graphs of the equations.

Graphical solution
Consider the linear graphs of y=1—xand y =2x +4.

Yy
10'/

)=2x+4
5 )

The graphs don’t have to be linear. Consider the graphs of a linear equation y = 1 — 2x and quadratic

The graphs have a point of intersection at (-1, 2).

equation y = K +1.

They have 2 points of intersection, at (0, 1) and (-2, 5).

y:x2+l

T T T T
-4 ) 2 4 *
_2_
y=1-2x

Nelson VICmaths Mathematical Methods 11 9780170448260




VL) = o VB BB R Simultaneous equations using graphs

Use graphs to solve the simultaneous equations x +2y —10=0 and y = 3x — 2.

Steps Working

1 Graphx+2y—10=0and y=3x-2. y

@ Exam hack ‘m

You can always check your solution by substituting

x and y into the 2 equations. 27 y=3x—2
4 5 5 S
7
2 Read the solution point from the graph. The point of intersection is (2, 4).

So the solution is x =2, y =4.

Algebraic solution

There are 2 algebraic methods for solving simultaneous equations.
The elimination method combines the equations to eliminate x or y.

The substitution method substitutes an expression from one equation into the other.

Ve S NI E S B Simultaneous equations using algebra

Solve the simultaneous equations x + 2y —10=0 and y = 3x — 2.

Steps Working

Elimination method x+2y=10 (1]

1 Rearrange the equations to get matching terms and 3x—y=2 ...[2]
add or subtract to eliminate x or y. f

These are the same equations as in the
previous example.

To match y terms, multiply [2] by 2.

x+2y=10 1]
6x—2y=4 ...[3]
Add [1] and [3]:
7x=14
Sox=2
2 Substitute x = 2 into the easiest equation, say [1], x+2y=10
tOﬁndy. 2+2y=10
y=4
The solution is x=2, y=4.
Substitution method x+2(3x-2)—-10=0
1 Substitute y =3x — 2 into x + 2y — 10 = 0 and solve 7x—14=0
to find x. x=2
2 Substitute x =2 into y = 3x— 2 to find y. y=3(2)-2
=4

You can always check your solutions by substituting

x and y back into the 2 equations. » The solutions are x =2, y = 4.

J

9780170448260 Chapter 1 | Equations and inequalities

23



For simultaneous equations involving non-linear equations, substitution is the only method.
Consider the equations y = 2x + 2 and 3x” + y = 3 and find where their graphs intersect.
Substitute the easier equation y = 2x + 2 into 3x” + y = 3.
3¢+ (2x+2)=3
3 +2x—1=0
Bx—1D(x+1)=0
1
x= 3 and x =-1

Substitute x values into the easier equation y = 2x + 2 to get matching y values.

y:2(§)+2=§ and y=2(-1)+2=0

138
The graphs of the equations intersect at ( 3 ,g) and (-1, 0).

m Simultaneous equations

Sketch the graphs of y = 2x + 2 and 3x” + y = 3 and find their point(s) of intersection.

| # Edit Action Interactive
L o 6l | & |f$;1|5imr|’i‘?| v ME]M v M
£1(x)=2: x+2 y=2x42 [a]
( =2+x+2
333,2.
/ 0.323 ) 67) 3x2+y=3
(-1,0) /1 x 3ox24y=3
S 1 5 = - .
2 =3
il 4 {0.3333,2.6567)
(=1,0) X,
-6.67 =) = %
—
Alg Standard  Real Rad (@
1 Add a Graphs page. 1 In the Main menu, enter the equations
- 2 -
2 Enter 2x + 2 then press enter to display the y=2x+2and3x"+y=3.
first graph. 4
3 Press menu > Graph Entry/Edit > Relation. Using Main menu is preferable to Graph&Table

as we don’t have to make y the subject before

4 Enter 3x* + y = 3 then press enter to display
we enter the equation.

the second graph.

5 Press menu > Analyze Graph > Intersection. 2 Tap Graph to open the Graph window

6 When prompted for the lower bound?, move 3 Highlight and drag each equation into the

the cursor to the left of the first point of Graph window below.
intersection and press enter. . o . . .
4 Adjust the viewing window for a suitable view.

7 When prompted for the upper bound?, move .
. . . 5 In the lower screen, tap Analysis > G-Solve >
the cursor to the right of the first point of . i ]
. . Intersection, pressing the right arrow to move
intersection and press enter. i
to the next point.

8 Repeat steps 6 and 7 to for the second point
of intersection.

9 Adjust the window settings to suit.

Nelson VICmaths Mathematical Methods 11 9780170448260



Algebraic solution Algebraic solution

# Edit Action Interactive

['Ls 3 I‘"‘)’ Imals‘“" -I-(-lf“' I [

)

y=2x+2
3x2+y=3 x,¥

1 8
x=-1 andy=00rx=-3— ndy=-; {{x:—l,y=0},{x=%.y=—g-}}?
1 Add a Calculator page. 1 In Main, open the Keyboard and select the
2 Press menu > Algebra > Solve System of Math1 soft keyboard.
Equations > Solve System of Equations. 2 Tap on the simultaneous equations template.
3 Keep the default settings and select OK. 3 Enter the equations and variables as shown
4 In the template, enter the equations as shown above, then press EXE.

above and press enter.

18
The points of intersection are (-1, 0) and ( 3 5)

m Solutions up to four unknowns

Solve the simultaneous equations for the 4 unknowns: x, a, b and c.

c=ax+b
a=2b
3c=a

a+2=hb

O Edit Action Interactive

c=a* x+b lI“"I"l‘nls'""’ = ] I"HI'H:

lvella=2"® Gasasd) c=ax+b IJJ}
iy | PP e a=2b T
a+2=b 3c=a ‘
=] -4 a+2=b a, b c,x
x==—and g=-4and b=-2 and c=— ‘
3 {x=— ,a==4, b==2, c—--s—} ,‘
1 Add a Calculator page. 1 In Main, tap the simultaneous equations
2 Press menu > Algebra > Solve System of template in Math1, then tap twice more to
Equations > Solve System of Equations. allow space for 4 equations.
3 On the next screen, change the Number of 2 Enter each equation as shown above with
equations: to 4 and change the Variables: symbols [a, b, ¢, x.
toa, b, c, x. 3 Press EXE.

4 Select OK.

5 In the simultaneous equation template,
enter the equations as shown above then
press enter.

1
The solutions are x = —g, a=—-4,b=-2,c= —é.
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The solution to simultaneous equations allows us to analyse how 2 straight lines intersect.

There are 3 possibilities:

o one unique solution (different gradients)

T

« 1o solutions (parallel lines: same gradient, different y-intercepts)
o infinite solutions (the same line: same gradient, same y-intercepts)

/

MORKED = VB0 Finding a constant in simultaneous equations

no solution, where m is a real constant.

Find the value(s) of m such that the simultaneous equations mx + 2y = 20 and (m + 1)x — 2y = 10 have

2 If the equations have no solution, then
the lines must be parallel, so their gradients
must be equal but their y-intercepts must be

1
3 Substitute m =— 5 to check that they are

NOT the same line.

4 Write the answer.

different (so that they are not the same line).

Steps Working
1 Find the gradient of both linear equations mx + 2y =20
by rearranging the equations in the form 2y =—mx+20
y=mx+c.
y=- % x+10

m
radient = ——
& 2

(m+1)x—-2y=10
(m+1)x—-10=2y

(m +1)x s
y= -
2

+1
gradient=mT

m m+1
2 2
-m=m+1

—2m=

1

m=——

2
y=——x+10
y=—x+10 [1]

(m—H)
= x—5
2
1
=—x-5 .2
=4 (2]

Nelson VICmaths Mathematical Methods 11

9780170448260



EXERCISE 1.7 Simultaneous equations ANSWERS p. 492

Recap

1 Make a the subject of the formula am + 5 =—4(m — 2).

2 [Z0i05i=8 Solve this equation for p:
1
v=—(p+v
p > (p+v)

Mastery

3 WORKED EXAMPLE 18 | Use graphs to solve the simultaneous equations x + 2y =8 and y = x — 2.

4 Use graphs to solve each pair of simultaneous equations.
a y=x+4andy=—x-6 b y=2x+landy=-x-2

5 WORKED EXAMPLE 19 ] Solve each pair of simultaneous equations algebraically.
a 3a+2b=12 b 3x—4y=38
4a-2b=2 2x+y=9

6 Solve the simultaneous equations y = x + 1 and X - y=1

7 [Uzs.5ilz: Solve each pair of simultaneous equations.

a x+y=10 b 2x+y=5 c x+3y=20
2x—=2y=5 x—=2y=5 2x+y=1

d x+y=1 e x—y=5 f 4x—y=4
2x+y=5 4x—2y=10 x+y=1

8 Solve the following simultaneous equations for x, y, a and b.

y=ax+b
x=a+2b
a=b

x=2y-1

Exam practice

9 The solutions or factors to the equation 3x* — x — 2 =0 are

2 2
A x=—1,§ B x=-1, —g C x-1)Bx+2) D (Bx—-1)(x+2) E «x

2
1, —
3

10 [P WORKED EXAMPLE 20 ] 2017N 2403 MODIFIED | The simultaneous linear equations mx + 7y = 12 and
7x + my = m have a unique solution only for

A m=7orm=-7
m=12orm=3
any value of m except =7 or 7

m=4orm=3

m O O W

any value of m except 12 or 1

9780170448260 Chapter 1 | Equations and inequalities 27
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Video playlist
Inequalities

Worksheets
Inequalities
on a number
line

Inequalities
review

28

11 [EIEZN 2019N 2208 | The simultaneous linear equations 2y + (m — 1) x = 2 and my + 3x = k have infinitely

many solutions for
A m=3andk=-2
C m=3andk=4
E m=-2andk=3

12 (3 marks) Let f(x) = x* — 4x — 8.

a Factorise the expression xt—4x-8.

B m=3and k=2
D m=—2andk=-2

1 mark

b Find the points of intersection between the graph of fand the line y = 4x — 8. 2 marks

Inequalities

An inequality is a mathematical statement that contains an inequality symbol rather than an = sign.

Inequality symbols are >, <, > and <.

Inequalities can be solved like equations using inverse operations, except for the following rules:

Solving inequalities

o When multiplying or dividing both sides of an inequality by a negative number, reverse the

inequality sign.

o When finding the reciprocal of both sides of an inequality, reverse the inequality sign.

Consider the true inequality -7 < 5.

Let’s make each term the negative of itself to get 7 > —5.

Consider the true inequality 7 > 5.

1 -1
Let’s ‘flip’ each term upside down to get 5 <-.

Notice the change of < to > to make it true.

Notice the change of > to < to make it true.

5
Consider the inequality 2 — x > 4.
So—x>2
Sx<=2 Notice the change of > to < to make it true.
Ve = SN B SR B Inequalities
2x+5
Solve for x the inequality £ S2x+1.
VSteps Working
X0 oxr1

Solve using inverse operations, cross-multiplying
first.

2x+5<6(2x+1)
2x+5<12x+6
-10x <1

When dividing both sides by (-10),
reverse the inequality sign: < changes to 2.

Nelson VICmaths Mathematical Methods 11
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Graphing inequalities
Inequalities can be graphed on a number line as an arrow with a closed or open circle.
A closed circle means the value on the number line is included, and is used for inequalities involving > or <.
8 9 10 11

T T
6 7

5

means x > 8 (8 included)

oo -
\©

~

1 2 3 4 5 6

means x < 5 (5 included)

An open circle means the value on the number line is not included, and is used for inequalities
o>

T T T T

-4 -3 —2‘ -1 0 1
3
1

-1

involving > or <.

§ 9 10 11 12 13 14 15 16
. 3 3 .
means x < 12 (12 not included) means x >—1— | —1— not included

m Solving inequalities
2x +
Solve the inequality XS > <2x—1.

ClassPad

@ Edit Action Interactive
m‘;] Simp | T8 | v | A5 v
=

TI-Nspire
%1 Kk
2x+5 [ 4 |
3 SZx—l.x) —
(x22)‘ |

x22
solve(
1 In Main, enter and highlight the inequality.

2: x+5
<2'x-1x

solve(
3
2 Tap Interactive > Equation/Inequality > solve.

1 In a Calculator page, press menu >
Algebra > Solve.

2 Enter the inequality followed by, x as Tap Keyboard > Math3 to access the < symbol
shown above. Press ctrl + = to access the 3 Tap OK.

mini-palette for the < symbol.

«l
o‘:

3 Press enter.
Video
VCE question
analysis:
Equations and

VCE QUESTION ANALYSIS
2019N 2BQ1 MODIFIED | 2019 Northern Hemisphere Examination 2 Section B Question 1 MODIFIED (8 marks)
The graphs of y, = (x — D3(x+2)% and V=16 1)%(x + 2) are shown on the axes below.
inequalities
b :

Y= (x- 1)3(x+2)°

¥, : (x—= DX x+2)°
29

The two graphs intersect at three points (=2, 0), (1, 0) and (¢, d). The point (¢, d) is not shown in the
Chapter 1 | Equations and inequalities

diagram above.
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Find the values of ¢ and d. 2 marks

b Find the values of x such that y, > y,. 1 mark
c i State the values of x where the graph y, = (x — 1)*(x + 2)* gives y = 8. 1 mark
i State the values of y where the graph y, = (x — 1)*(x + 2)° gives x=—1. 1 mark
d State the values of x for which
iy =(-1’x+2)°>0 1 mark
iRy =i = 1)*(x+2)°>0 1 mark
e Show that the value of y, is the same for x =1 + m and x = -2 — m, for all m. 1 mark

Reading the question
o The question is centred around the concept of graphs intersecting and being higher or lower.
o The first question asks where the graphs are equal.
o The second question asks where the graph of y, is higher than y,.

o The question then moves into substitution of numbers and variables representing constants.

Thinking about the question

o As this question is technology active, the questions are much easier to solve than it looks on
initial reading. Make sure your CAS is on ‘exact’ (TI) or ‘Standard’ (ClassPad) to get exact values,
even if they are surds.

o If we want to find where y = 8 on the graph y,, we just solve the equation y, = 8 for x and the
answer will be given.
o Parteisa ‘show that question, so we must show a certain number of steps.

Worked solution (v = 1 mark)

a Equate y,and y,togivex=-1,x=1,x=2

& Edit Action Interactive
1] o [ sime] [+ [+

'solve( (x=1) 3+ (x+2) 3=(x~1) 2. (x+2) 3, x) &
{x=-2, x=1, x=2}

solve((x-1)3- (x+2) 3 =(x-1)- (x+2)3,x)

x=-2orx=1lorx=2

(x=1)> (x+2)>pe=2 64 (x-1) 3 (x+2) 3 | x=2
64

The 2 graphs intersect at 3 points (=2, 0), (1, 0) and (¢, d), so c=2.
Substitute x = 2 into either equation to get y = 64.
c=2,d=64/

b We need to find x values where y, > y,.

Using CASwe getx<—2andx>2./

£+ Edit Action Interactive

ots’%IJL,, Ifg’\‘ Isimylf'_lx‘?l Y IH*I '[ t

solve((x-l)z- (x+2)3>(x— 1) 2. (x+2) 39‘)

<=2 orx>2 solve((x-1) 3 (x+2) 3> (x-1) 2o (x42) 3, x) &
{x<-2, 2<x} |
Nelson VICmaths Mathematical Methods 11 9780170448260




c i State the values of x where the graph y, = (x — 1)*(x + 2)° gives y = 8.

This means to solve (x — 1)*(x + 2)* = 8.

£ Edit Action Interactive
2 2 [nfsn%l\nj’ ﬁ::lls“"l'lﬁ*flvli\i-*lv[
solve((x—l)"- (x+2)"=8,x)
-(J17 +1) 17 -1 solve( (x-1) 3+ (x+2) 3=8, x)
T [ -Vi7_1 _VI7_1
= = Ut g 2
(e-1)3- (e+2)3pe=2 -8 (x=1) 3+ (x+2) 3 | =1
-8
-1+
e 1+17 s

2
i State the values of y where the graph y, = (x — 1)°(x + 2)° gives x = —1.
This means to find y, when x =—1. Use CAS.
Refer to the graph to identify where these points are to confirm your answers.
y=-8v
diy>0
This means to find x where the graph y, is above the x-axis.

Refer to the graph to identify where these points are to confirm your answers.

© Edit Action Interactive

%1 I > I{;{; ISimrIL‘vl 'Iﬂ'%*'l '

solve((x-l)a- (x+2)3>0,x) x2onet solve( (x-1) 3°(x+2) 3 >0, x) =
{x<=2, 1<x}
solve((x- 1)2- (x+2)3>0 ) B2 amaaa ;{ "
X solve ( (x=1) 2+ (x+2) 350, x)

{x>-2 and x#1}

x<=2andx>1/

i y,>0
This means to find x where the graph y, is above the x-axis.
x>-2and x # 1 (consider what x # 1 means) v/

e Show that x=1+ m and x = —2 — m have the same value of y, for all m.
CAS can show this, but this question is a ‘show that’ question.
Given y, = (x — 1)°(x+2)*%
Whenx=1+m

y=1+m—-1>1+m+2)°
=m®(m+3)°

Whenx=-2-m

y=(2-m-1>(2-m+2)’
= (-m—3)* (-m’)
= [-1(m +3) [((-1)m]’
= (-1)(m +3)’ (=1)m’

=(m+3)>m®as required v/

9780170448260 Chapter 1 | Equations and inequalities
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EXERCISE 1.8 Inequalities ANSWERS p. 492

Recap

1 Solve the simultaneous equations 2x + y = 5 and x — 2y = 10.

2 Solve the simultaneous equations y = x* + 1 and 2x + y = 6.
Mastery

. . ., 2x+5
3 WORKED EXAMPLE 21 | Solve for x in the inequality <2x+1
—-2x -5
4 Solve for x in the inequality Y s x-l
5 The solution to the inequality x + 7 > 2x+ 4 is
A x>3 B x<3 C x<3 D x23 E x=3

6 The number line representing the solution to the inequality x + 7 > 2x + 4 is

A o B o
T T T T T T T T T T
-1 0 1 2 3 -1 0 1 2 3
c B e D -0
T T T T T T T T T T
-1 0 1 2 3 -1 0 1 2 3
E [ ]

7 The solution to the inequality X ;L > > 3x4—1 is

A x>11 B x<11 C x<11 D x=11 E x=11
8 The solution to the inequality al ;L > > 3x4— ! +1is

A x>7 B x<7 C x<7 D x27 E x#7

xX+5 1
9 The number line representing the solution to the inequality — > 5 +2 is

A ° > B © >
T T T T T T T T T T
-1 0 1 2 3 -1 0 1 2 3
c o D -0
T T T T T T T T T T
-1 0 1 2 3 -1 0 1 2 3
E [ ]

10 The graphs of the equations x + 2y = 8 and 3x — 4y = 2 intersect at the point

18 11 18 11
2 4 55 5 5

5 5

Nelson VICmaths Mathematical Methods 11 9780170448260



@ Chapter summary

Index laws

ay' 4"
amXanzam+n (_) =—
b b
m n _ m-n 0 _
a +a =a a =1
n _ 1
(am) = g™ a" = =
a
1
(ab)' = b & = 4a
P
q

& =4 = (4

Binomial expansions

A binomial expression has 2 terms, for example,
x +4and 3x* — 6.

A binomial product is 2 or more binomial
expressions multiplied together.

It has the form (a + b)(c + d).
(a+b)(c+d)=ac+ad+ bc+ bd

A quadratic expression is of the form ax® + bx + c.

FOIL method

First terms, Outer terms, Inner terms, Last terms

Perfect squares
(a+bP’=a*+2ab+V*
(a—0b)*=a*>—2ab+ b*

Difference of two squares
(a+b)a-b)=a’-b*

Quadratic equations

A quadratic equation is an equation where

the highest power of the variable is 2. It has the
general form ax® + bx + ¢ = 0, and can be solved by
factorising, completing the square or using the
quadratic formula.

Completing the square
Solve by completing the square:

1 Write the equation in general form: ax” + bx +c=0.

2 Take out the common factor of a.

3 Halve the coefficient of x and then square this
number.

4 Add and then subtract (to compensate) the
number found in the previous step.

5 Recognise the perfect square and factorise.

6 Solve for zero to find the roots of the equation.

9780170448260

The quadratic formula

—b £ b — dac
e 2a
Solve using the quadratic formula:
1 Write the equation in general form:
ax* +bx+c=0
2 Identify the values of g, b and ¢ and substitute
into the quadratic formula.

3 Simplify where necessary (including the surd).

The discriminant

In the quadratic formula, the expression under
the square root symbol, A = b? — 4ac, is the
discriminant.

The sign of its value gives information about

the number of roots of the quadratic equation,

ax* + bx +c=0:

o If A <0, the quadratic equation has no real roots.

o If A=0, the quadratic equation has 1 real root,
which is rational.

o If A> 0, the quadratic equation has 2 real roots.
- If A is a square number, the 2 roots are rational.

- If A is a not a square number, the 2 roots are
irrational (surds).

Changing the subject of a formula

A literal equation is an equation with more than one
variable, such as ax + b = c. The most common literal
equation is a formula. We can rearrange a formula to
make one of the variables the subject of the formula.

Simultaneous equations

Simultaneous equations are 2 or more equations
with more than one variable. These are solved
together to give a set of values that satisfy all
equations. Simultaneous equations can be solved
algebraically or graphically. Graphically, the
solution is the point(s) of intersection of the graphs
of the equations.

Algebraic solution

The elimination method combines the equations
to eliminate x or y.

The substitution method substitutes an expression
from one equation into the other.

Chapter 1 | Equations and inequalities
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Inequalities
Inequality symbols are >, <, > and <.

Inequalities can be solved like equations using
inverse operations, except for the following rules:

« When multiplying or dividing both sides of an
inequality by a negative number, reverse the

inequality sign.

« When finding the reciprocal of both sides of an

equality, reverse the inequality sign.

Nelson VICmaths Mathematical Methods 11

Graphing inequalities

Inequalities can be graphed on a number line as an

arrow with a closed or open circle.

A closed circle means the value on the number line

is included, and is used for inequalities involving

>or<.
T T T T T T T T
1 2 3 4 6 7 8 9
L E——
T T T T T T
5 6 7 9 10 11

An open circle means the value on the number

line is not included, and is used for inequalities

involving > or <.

9780170448260



Cumulative examination 1

Total number of marks: 10 Reading time: 4 minutes Writing time: 15 minutes

Technology is NOT permitted.

1 (6 marks) Lety= #, + 1.
(x=1)
a Find the value of y when x=2. 1 mark
b Find the value(s) of x such that y = 3. 2 marks
¢ Evaluate y when x =—1. 1 mark
d

Consider the line, y = x + 1, crossing the graph of y = 1) + 1 at the point (g, b)

where a and b are integers.

Find the values of a and b. 2 marks

2

7
2 (2 marks) Find the value of the constant a in the rule y = ax3 + /x given that y= ——~

when x = 64.

3 2019N 1Q5a MODIFIED | (2 marks) Let h=+/2x + 3 — 2. Find the value(s) of x such that h*= 1.

9780170448260 Chapter 1 | Cumulative examination 1
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Cumulative examination 2

Total number of marks: 19 Reading time: 4 minutes Writing time: 30 minutes

Approved technology is permitted.

Section A 5 multiple-choice questions 5 marks

1 The graph of y = 4 — 2x has an x-intercept of
A —4 B -2 CcC o0 D 2 E 4

2 The graph of y = x* + 2x — 3 has x-intercepts at
A 3only B 3andl C 3and-1 D —3andl1 E —3and-1

3 XYY 20172407 | The equation (p—l)x2+4x=5— p has no real roots when
A p'—6p+6<0 B p’—6p+1>0 C pP-6p-6<0
D p’-6p+1<0 E p’-6p+6>0

4 If x + a is a factor of x* + 3x + a, where a # 0, then the value of a is

A —4 B Oor—4 c o D Oor2 EY

~

185

5 2019N 2AQ6 MODIFIED | The equation (x* +1)*+1 = »

has real solution(s)

V13 V13 V13 3
A x:i— B x=—— C x:_# D x=—
4 4 2 2

m

x

1l

I+
N | W
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Section B 1 question 14 marks N
=
3 o
1 (14 marks) Let y=x"— 5x for —1 <x < 6. The graph of y is shown. -
g
10 -
5 x
w
T T T T m
. 2 6 * >
=
_10— <
-
=
=
State the x-intercepts. 2 marks 3
b Find the coordinates of the turning point. 2 marks

¢ A(-1, a) and B(1, b) are two points on the graph.
i Find the equation of the straight line through A and B. 2 marks
ii Find the distance AB. 1 mark
d Let C(-1, ¢) and D(1, d) be two points on the graph of y = x* — kx, where k is a constant.

i Find the distance CD in terms of k. 2 marks
ii Find the values of k such that the distance CD is equal to 2k + 1. 1 mark
e Find the point(s) of intersection between the line y = x and the graph of y = x* - 5x. 2 marks

f Find the point(s) of intersection between the line y = x and the graph of y = x* — kx
in terms of k. 2 marks

9780170448260 Chapter 1 | Cumulative examination 2 37
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@ Functions and relations

Relations

A relation R is a set of ordered pairs (x, y), where x € X and y € Y. X and Y are usually both the set of real
numbers. We can show that an ordered pair belongs to a relation R by writing (x, y) € R or y = R(x). The set
of values of the independent variable x is called the domain and is often the set X. The set Y is called the
co-domain and the set of values of the dependent variable y is called the range.

We can show a relation as a rule (formula), a list of ordered pairs, a table, a mapping or a graph.

A mapping shows ordered pairs connected by arrows from the x values to the y values.

w
o
<
>
w
>
o
o
=
s
n
w
(a]
S
Q
=
=
(7]

)
4
VK

Video playlist
Functions
and relations

Worksheet
Functions and
relations

WORKED = ¢\ B E Mappings and ordered pairs

The mapping shows the relation M.
a Write M as a set of ordered pairs.
b Show M as a table.

c State the domain and range of M.

Steps Working
a Write the ordered pairs. M={(3,2),(3,12), (5,5), (7, 4), (7,5), (9, 4), (9, 12)}
b Write the ordered pairs in a table. n 3035717191009
Vo 2 | 12| 5 | 4| 5|4 12

¢ 1 The domain is the set of first domain = {3, 5, 7, 9}

numbers. Write Fhe domain and

range in order.
2 The range is the set of second range =1{2, 4, 5, 12}
numbers.

9780170448260 Chapter 2 | Functions and graphs
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Worksheet
Function
notation

40

Functions

A function y = f (x) is a relation such that each x value in the domain has only one ordered pair (x, y).
In other words, each x value matches with only one y value.

A function may be shown by a rule like f (x) = 5x — 1.

f (x); pronounced f of X} is called function notation, and means the rule for operating on the independent
variable, x.

The value of f(x) at x = ¢ is written as f (¢).
For example, f(2) is the value of f(x) = 5x — 1 when x = 2.
f2)=5x2-1=9
More formally, a function can be written like this: f: R — R, y = x* + 3, whose domain and co-domain are
the real numbers.

e i1 = 2 0T B S8 Relations and functions

State whether each relation is a function.

b x*=y c y=~x-2 d

Steps Working
a 1 Write the ordered pairs. Relation is (=3, 9), (4.5, 5), (6, 4), (10, 6).
2 Write the conclusion. It is a function because each x value occurs only once.
b 1 Do any ordered pairs have the same (2,-2) and (2, 2) have the same x value.
x value? x = 2 has 2 matching y values.
2 Write the conclusion. It is not a function as there are 2 ordered pairs with the
same x value.
¢ 1 Do any ordered pairs have the same Vx — 2 means the positive value so each ordered pair
x value? (x, ) is unique.
2 Write the conclusion. It is a function because each x value has one y value.

d 1 Do any ordered pairs have the same x value? (0, 0.5), (0, 0), (0, —0.2), (0, —1) ... have the same x value.

2 Write the conclusion. It is not a function as there are an infinite number of

ordered pairs with the same x value.

We can usually determine from a graph if a relation is a function. A function will show any value on the
x-axis with (at most) one value for y. A relation may have 2 or more y values for one x value: there will be
2 or more parts of the graph directly above each other.

If any vertical line intersects the graph of a relation at most once, then it is a function.

If a vertical line intersects the graph of a relation in more than one place, then it is not a function.

y Y
/
x x
\
A function Not a function
Nelson VICmaths Mathematical Methods 11 9780170448260



‘WORKED = ¢\ |8 =<} Relation and function graphs
State whether each of the following shows the graph of a function.
a y b Y

61 27 y=—(x—2)(x+1)

47 (x—2)+(y-27=9 i
\ b 1 1 X
T T T X I
2, | 4 6 L,
¢y dy
5 54
4- 4- —
34 3+ o—o
2 ._/\_. 24
14+—e o—e 14 —

1234 5% 123 4 5% wB
Steps Working b. 24
a 1 Do any points have the same x value? There are 2 points at x = 2: (2, 5) and (2, —1).

2 Write the conclusion. (x—2)*+(y—2)*=9is not a function.
b 1 Do any points have the same x value? There are no points with the same x value (but
some with the same y value).
2 Write the conclusion. y=—(x—2)(x+1) is a function.
¢ 1 Do any points have the same x value? (3,2),(3,2.1) ... (3, 3) have the same x value.
(1, 1) and (1, 2) have the same x value.
2 Write the conclusion. This graph does not show a function.
d 1 Do any points have the same x value? There are no points with the same x value. At x =4,
there is no value, so the relation is undefined there.
2 Write the conclusion. This graph does show a function.

Most relations with rules like ‘y = algebraic rule involving x* are functions.

Jx—3

For example, y = +
P&y x—-5 \/7—x

is a function. Each value of x in its domain has only one corresponding
value of y.

Consider this function mapping:

Each x value in the domain is matched with a unique y value. In the pairings, G
there aren’t any repeated x or y values. This is called a one-to-one function. I

The function {(1, 3), (2, 1), (3, 5), (4, -1)} is also one-to-one: every x or y value
is in only one ordered pair.

Now consider this function mapping:

Each x value in the domain is matched with one y value. But notice that ~_
= = = = = = ‘
forbothx=5and x=7,y=5. And for bothx =3 and x =9, y = 12. In the

pairings, there are repeated y values. This is called a many-to-one function.

The function y = x” is also many-to-one: there are many x values that match
with the same y value, for example, {(7, 49), (-7, 49), (2, 4), (-2, 4), (1, 1), (-1, 1)}.
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EXERCISE 2.1 Functions and relations ANSWERS p. 492

Mastery

1 WORKED EXAMPLES 1,2 | Write each mapping as ordered pairs. State the domain and range and whether
the mapping is a function or not. If it is a function, state whether it is one-to-one or many-to-one.

a b

ﬁ \!l

2 State whether each set of ordered pairs is a function or not. If it is a function, state whether it is one-to-
one or many-to-one.

a {(3,5),(4,7),(57),(6,7),(8,9), (9 5), (12, 5)}

b {(4,7),(5,6),(5,4),(7,3),(8,2), (9, 1), (10, 0)}

c {(7,3),(3,7),(9,2),(2,9), (4,8), (8,4), (5,7), (7, 5)}
d {(0.1,3),(0.3,9),(0.5,15), (0.7, 21)}

3 State whether each relation is a function.

B a2 2
a 23 ¥, p =3 _OF2r
5 3 25 9
c 12x-3y*=5 d 15x-3y°=7
4 WORKED EXAVPLE 3 | State whether each graph represents a function.
a y b y c y d y
X X D — x
\l \
\j
~—s O>—F
— X X
x X

Exam practice

5 The relation P is shown by the mapping below.

The domain and range are

A domain: {0, -1, 1, -3, 3,4, 7, 12}, range: {1, 2, 3,4, 5,6, 7, 8,9, 10}
domain: {0, -1, 1, -3, 3,4, 7, 12}, range: {1, 2, 3,4, 5, 7, 8, 9, 10}
domain: {0, -1, 1, -3, 3,4, 7, 12}, range: {1, 2, 3,4, 5, 7, 8, 10}
domain: {0, -1, 1, -3, 3,4, 7, 12}, range: {1, 2,4, 5, 7, 8}
domain: {-1, 1, 3, 4, 7, 12}, range: {1, 2, 4, 5, 7, 8}

m O O W
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6 Which relation is a function?

A y=x2—5 B y2+5=x () y2=x+5
1 1

D —=— E x2—y2=5
x oy +1

7 Which relation is not a function?

1 1 1
A y= B y:x2_52 C —=—
x+3 x y

D xZ:y2+9 E \/;=x2+4

@ Functions and graphs

)
A&
‘ WORKED EXAMPLE 4 BSiir:Ue[o I I=H
A Chemistry student lubricated the plunger of a 30 mL syringe with silicone grease, pushed the plunger ;ﬂ:if,g,l:y:,f;
down to the 20 mL mark and put a cap on the end. She put the syringe into an ice-water bath and stirred graphs
the water while slowly heating it. The temperature and volume readings were as shown below.
Draw a graph and determine the relationship between the temperature and volume of air in the syringe. —
wWB
Temperature (°C) 0 15 30 45 60 75
Volume (mL) 19.2 20.0 21.0 22.3 23.4 24.3 p-25
Steps Working
1 Plot the points on suitable graph paper.
25 7
The points appear to be in a line, so draw a 24
line of best fit. ’ET 23 1
S 22
g 21
g °l]
5 20
19
18'I'|'|'|'|'|'|'|
0 10 20 30 40 50 60 70 80
Temperature, T (°C)
2 Choose 2 points on the line. (0, 19) and (70, 24) are on the line.
24-19 1
3 Calculate the gradient of the line. m= =—
70-0 14
. . . 1
4 Write the equation using y = mx + c. V= HT+ 19

The T-intercept of V= 114190 easily calculated. When V' =0, T'=-266. It suggests that the volume of
14

the gas would be 0 mL at a temperature of —266°C. The lowest possible temperature (absolute zero) is now
thought to be —273.15°C.

In many cases, we cannot draw a straight line. Points may also be widely scattered.
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VLo 4= S N B S8 Plotting a linear function

300 sausages are to be sold for $2 each.

¢ Draw a graph of the profit function.

b How many sausages must be sold to make a profit?

The total cost of running a sausage sizzle at a school sports day is $150.

a Write the function for the profit made when # sausages are sold.

d How much profit is made if all 300 sausages are sold?

2 Write the answer.

Steps Working

a Profit = sales — cost P(n)=2n-150

b 1 Find P(n) > 0. 2n—150>0
n>75

A profit is made when more than 75 sausages are

sold.

¢ 1 Choose some values of n and calculate P(n).

P(0) =—-150, P(100) = 50, P(200) =250

2 Write the answer.

2 Draw the graph. P($)
500
The answer to part d agrees 400 .
with the graph at this point.
300
200 >
Label the graph with P(m)=2n-150
its equation. 100+
J
0 T T T T T T T
5 100 150 200 250 300 350 n
—100
—200
d 1 Find P(300). P(300) =450

If all the sausages are sold, there is a profit of $450.

From the graph or the function, the intercepts on the above graph are (0, —150) and (75, 0). For a linear
function, we only need to plot 2 points to draw the line, but check using a third point.

Quadratic functions have an x” term with a possible x term and constant.

Nelson VICmaths Mathematical Methods 11
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VL) o N B R Graphing a quadratic function

Graph f(x) =x*-2x-3fromx=-3tox=5.

Steps Working
1 Make a table of values.

e -3 | 2| -1 0 1 2 3 4 5
i 12 | 5 0| -3|-4|-3|60 5 12

2 Plot the points and join them with a y
smooth curve.

( fl)=x*-2x-3

The zeros are —1 and 3.

s

The y-intercept is —3.J

-~

The turning point is (1, —4).

It is a minimum.

The curve above slopes down, then flattens out as it approaches the minimum point. Then it slopes upward.
The gradient is negative for x < 1, zero at x = 1 and positive for x > 1. It is concave up. You can remember
this as being cup-shaped.

A stationary point is a point on a graph where the gradient is zero. Any minimum or maximum on a
continuous curve must be a stationary point.

A point of inflection is a point where a graph changes from concave up to concave down, or from concave
down to concave up. (Inflection means ‘bend’)

Concave down
/ Point of inflection

'/)/ Concave up
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m Sketching graphs

Sketch the graph of f(x) = % +4.
x

@ Edit Zoom Analysis ¢ (x]

10

1 Add a Graphs page.

5
1 In Main, enter the expression 2 +4.

5
2 Enter the function f1(x) = 5 +4.
x —

2 Tap and open the Graph window.

3 Press menu > Window/Zoom > Window Settings. — . . .
3 Highlight the expression and drag it down into

4 Keep the default X window settings and change
the Y settings to YMin: -10, YMax: 10, Scale: 1.

the Graph window.
4 Tap View Wi .
5 Press menu > Analyze Graph > Zero. ap View Window

6 When prompted for the lower bound?, click to 5 Tap Default and change the Y settings to:

the left of the x-intercept. YMin: -10 YMax: 10 Scale: 2.

0 1
7 When prompted for the upper bound?, click 6 Tap Analysis > G-Solve > Root.
to the right of the x-intercept to display the
coordinates. 7 Press EXE to label the coordinates.

8 Press menu > Geometry > Points and Lines 8 Tap Analysis > G-Solve > y-Intercept.

> Point On. 9 Press EXE to label the coordinates.

9 Click on the graph and then on the y-intercept

to display the coordinates.

The function is not defined at x = 2, and nearby the magnitude of f(x) becomes very large.
Asx — —o, f(x) <4 and f(x) — 4.
Asx — oo, f(x) >4 and f(x) — 4.

The line y =4 is called a horizontal asymptote. This is a value that the function approaches as x — —oo or
x — oo, In this case, the function approaches 4 for both cases.

The line x = 2 is called a vertical asymptote. As x approaches 2, the function becomes very large in
magnitude. Functions are undefined at vertical asymptotes.
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Features of a graph with no specific rule
The graph of a function is shown below. Identify and approximately locate its significant features.
y
5
4
3
2
1
7 6 -5 4 -3 2 -10| 1 2 3 x
-1
-2
-3
—4
Steps Working
1 Where does the graph cross the y-axis? The y-intercept is about (0, 1.5).
2 Where does it cross the x-axis? The zeros are about —3.5, 2.8 and 7.5.
3 Are there any maximum or minimum points? There is a minimum at about (—0.8, 1) and a
maximum at about (1.6, 3).
4 Are there any asymptotes? There may be a horizontal asymptote about y = -2
and vertical asymptotes at x =—2 and x=3.7.
5 Are there any points of inflection? Points of inflection occur at about (0.3, 1.9) and (6, —2).

Inverse functions and graphs

A relation R is a set of coordinate pairs (x, y). The inverse relation R is the relation formed by swapping all
the ordered pairs to (y, x).

If the inverse relation of a function is also a function, then it is called the inverse function and is written as
f7(x). This function is the opposite to y = f(x), and links the values of y in y = f(x) back to x. For example, if
f(3) =5, then f'(=5) = 3.

A function has only one y value for each x value in its domain. This also applies to the inverse function.

Its x values are the y values of the original function, so each y value can have only one x value. So this means that
for a function to have an inverse function, it must be one-to-one: each x value has only one y value and each

y value has only one x value. Both the x and y values in the ordered pairs of the function are unique.

The function y = 3x — 5 is one-to-one so it has an inverse.

The function y= x% — 3 is not one-to-one so it does not have an inverse. However, we can restrict its domain
to make it one-to-one so it does have an inverse, for example, restrict it to [0, oo).

9780170448260 Chapter 2 | Functions and graphs
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Ve s = 2 T B SR Existence of an inverse function

State whether each function has an inverse function. If not, suggest how the domain could be restricted so

that it does.

a (3,7),(4,9),(5,9), (7,11), (9, 17)

b y= 44

c f(x)=(x+4)(x—3)

Steps Working

a 1 Check the y values for duplicates.

2 State the conclusion.

3 Suggest a restriction.

(4,9) and (5, 9) have the same y value.

The function is not one-to-one, so the inverse is not a
function.

Restrict the domain to either {3, 4, 7, 9} or {3, 5, 7, 9}
so it is one-to-one.

Check y values for duplicates.

1
2 State the conclusion.

Every y value is unique.

The function is one-to-one, so the inverse is a function.

¢ 1 Check y values for duplicates.

2 Find the turning point.

3 Suggest a restriction.

f(-4)=0and f(3) =0, so it is not one-to-one and the
inverse is not a function.

There is a minimum (-0.5, —12.3), so the values above
—0.5 duplicate those below.

Make the domain x < —0.5 or x = —0.5 so it is one-to-one

and the inverse is a function.

The inverse of a function has the x and y values swapped. To find the rule for the inverse of a function, swap

x and y and make y the subject of the equation. The graphs of an inverse function and the original function

are mirror images of each other in the line y = x.

VL) U= 2 VB SRR Function and inverse function graphs

Find the inverse function of each function and sketch both, together with the line y = x.
a f:(1,0),(-3,2),(4,5), (5 -3), (-1,-2)

b f(x)=2x+6
Steps Working
a 1 Write the inverse function. f_lz (0, 1), (2, -3), (5, 4), (-3, 5), (-2, -1)
2 Plot the graphs in different colours. 3.5) y @s)
Draw y =x. . 5 - <
4 4 /e
| G4
(-3,2) Pyl
° 2 A ///
1 = fii’/
0.0l L0
—3—.2—/_yl’/_ 1 2 3 4 5%
(-2,-1)
s =2
///(_1) _223 i . (5) :3)
//’ (2,-3)

Nelson VICmaths Mathematical Methods 11
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b 1 Swapxandy. X=2y+6

2 Make the new y the subject. 2y=x-6
1
=—x-3
4 2
. 1
3 Write the inverse function as ' (x). )= Ex -3
4 Find some points on the graphs. f(-1)=4,f(-5) =4,

[ =-5f"@=-1

5 Draw the graphs in different colours.

The graph of an inverse function is the graph of the original function reflected in the line y = x.

EXERCISE 2.2 Functions and graphs ANSWERS p. 492

Recap

1 Consider the 3 relations X = {(3, 5), (-2, 3), (0, 4), (2, 5), (5, 3)}, Y ={(6, 2), (2, 5), (3, 7), (6, 3), (7, 3)}
and Z=1{(2, 2), (1, 4), (3, 7), (0, 0), (5, 8)}.

Which of the following is true?
A None of them are functions. B Only Z is a function.
C Y and Z are functions. D Xand Z are functions.

E All of them functions.

2 Consider the 3 relations

Fi3p—ad=1  gsc-4p=1 W22 -3
Which of the following is true?

A Only h is a function.
B fand h are functions.
C They are all functions.
D gand h are functions.

E None of them are functions.
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Mastery

3 WORKED ExAMPLE 4 | A call-out fee for a tradesperson normally covers some repair time. A whitegoods

repairer’s call-out fee covers the first half-hour and subsequent time is charged in half-hour lots
Some recent jobs cost $256, $415, $626 and $312, exclusive of GST. They took 2h, 1h, 3h and 1 h
respectively. The cost of parts were $35, $242, $357 and $115 in the same order.

Draw a graph of the call costs (less parts) against time.

a
b Find the equation of the line, where T is the total cost of repair and ¢ is the time taken for the repair.

(2

What is the hourly rate?
What is the call-out fee?

[=%

1
e What is the cost for a job taking 25 h with parts costing $153, exclusive of GST?
f What is the cost including GST?

4 WORKED EXAMPLE 5 | A group of students used the school kitchens to make 102 sushi rolls to sell at a
school function. They were selling the sushi rolls for $2.50 each.

One of the students worked out they would have to sell over 47 sushi rolls to make a profit.
a What is the gradient of the graph showing the profit against the number of sushi rolls sold (#)?
b Write the profit function in terms of the number of sushi rolls sold.

By 4 pm, they had sold 87 sushi rolls. How much profit did they make?

d After 4 pm, they sold the rest at $1.50 each. Draw a graph showing the profit against the number sold
from n =0 to n=102.

e What was the profit as a percentage of costs for the full day? Round your answer to the nearest percentage.

5 workeD ExaVPLE 6 | Sketch the graph of each function for the specified domain.

a f(x)=(x—2)2f0r—1SxS5

b g(x)=(x—2)2—3for—1SxS5

c h(x)=(x+2)(4—x)for-4<x<6
d flx)=(x+2)(4—x)+3for4<x<6

e g(x)=6—4x—2x2for—5SxS3

6 Sketch the graph of each function, comment and approximately locate its significant

features.
a f(x)=9x- X b g(x)=x—-1)(x+2)(x-3)
x—3
AR R T
e y=3" f y=3"-2
—_ o (x+1) —3_4gx-2
g flx)=2 h gx)=3-4

7 workeD ExaMPLE 7 | Identify and approximately locate significant features of each graph.

a b

—3—2—10/2 3%
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8 The population of mice in a grassed paddock over a period of 10
7 months is on the right.

Describe the characteristics of the graph and state possible reasons
for the shape.

Population (’000)
P )

F M A M J J A S
Month

The graph on the right shows the heart rates of two people,

—
N
(=}

one fit and the other unfit, before, during and after a period of

10 minutes exercise. 120

a Describe the characteristics of the graphs.

'S
[}

b When did they start exercising?

(=}

Heart rate (beats/minute)
oo}
S

¢ Comment on their recovery times. 0 5 10 15 20 25 30 35

Time (minutes)

10 WORKED EXAMPLE 8 | State whether each function has an inverse function. For those that do not,

suggest how the domain could be restricted so that it does have an inverse function.
a {(_3) 5)) (_1’ 6)) (0) 4)) (1) 3)) (4) _6)’ (3’ 1)}
b {(_4) 2)) (_2’ _1)’ (1) 4)) (3) 4)) (5’ 5)) (7’ 5)7 (8’ _4)}

c f(x)= %x—z
d f(x)=1—x2+4x

e flx)= —

x—3

+2
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11 woRKED ExAMPLE 9 | Find the inverse function of each function and sketch both, together with the

line y = x.
a f: {(_1’ _3)) (_2’ _2)) (1) 3)’ (2) 4)’ (3’ 6)’ (57 _4)}
b f(x)= ix+ 2
c flx)=3x-4
d f(x)= 1 +2
X

e f(x)=(x—2)3+1

12 Copy each graph and sketch its inverse function in a different colour.

a y b y
6 4
4 3 -
2- 27
1_
_8 _6 _2 0 2 4 6 x T T T T T T T
<2 —4—3—2—10 1 2 4 %
- fx)
. ] f@
- =3
-8 g )
c y d y
44 6 -
(%)
N 4y @

2
1 1 T T T T 0 T T T
-8 -6 -4 -2 jZ 4 6 X
T T T T T T T -2

Exam practice

13 (4 marks) Two quadratic functions are given by f(x) = 2x* — 4x + c and
gx)=bx - 2x% +5.
a What are the values of b and c if they intersect at (5, 5)? 1 mark
b What is the value if b = c and they intersect when x = 3? 1 mark
¢ If b=, write a relationship between the coordinates of the point of intersection (f, g). 2 mark